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C H A P T E R  1  

Introduction 

This guide will take you through the relevant steps so that you will be able to make the 
most of your LogTag products. The guide is structured into chapters that will guide you 
through the process of installing the software, using the LogTag products and lastly some 
of the options that are available to you for making your efforts and experience of using 
the software as efficient, effective and pleasant as possible.  

The chapters in this guide are placed in an order that you will need to follow in order to 
successfully use the LogTag products first time. Experienced users of the software may 
choose to skip the first two chapters. However, if you are about to use a newer version of 
a LogTag and/or Interface Cradle, we recommend you at least skim the installation 
chapter for any relevant changes that should be performed prior to using your new 
version of LogTag hardware.  

This guide covers all the features included in version 1.4 of the LogTag Analyzer software. 
The chapter "Finding your software version" included later in this guide will help you 
through the process of finding out what version of the LogTag Analyzer software is being 
used and will help explain and determine if this version of the guide refers to the version 
of the software being used. The chapter "Getting updated software" included later in 
this guide will help you through the process of obtaining an updated copy of the software. 
Therefore, if you find a feature described within this guide that does not appear in your 
software and/or a feature within the version of software being used that is not described 
in this guide, then we recommend you obtain a newer version of the software and/or a 
newer version of this guide. You may obtain a free online copy of the latest version of this 
guide from the LogTag Recorders Internet site, www.logtagrecorders.com. 

Although this guide includes all the relevant information to install and use the product 
range supplied by LogTag Recorders, there are at times an expectation that the reader is 
familiar with using their computer and the Windows® operating system. If a feature of 
the software is specific to a version of the Windows® operating system, the guide will 
indicate appropriately for you the relevant differences. 

Feedback, positive or negative, about the software, the LogTag products and/or this guide 
is welcome. If you believe the products could be improved, you are welcome to send us 
your comments and we will do our best to include the improvements in a future release. 
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C H A P T E R  2  

Installing the software 

To make use of your LogTag you will need to first install the software on your computer. 
This will allow you to prepare your LogTag(s) for use, retrieve the readings the LogTag(s) 
have recorded, and analyze the data. This chapter will take you through the steps 
necessary to successful install the software on to your computer so you can begin using 
your LogTag(s). The process of installing the LogTag Analyzer software should be very 
familiar to users that have previously installed other software and therefore some 
experienced users may choose to only skim read or entirely skip this chapter. If you are 
new to using a computer and/or unsure about installing the software, we recommend you 
read the remainder of this chapter. 

In This Chapter 

System requirements..............................................8
Finding your computer specifications .......................8
Getting a copy of the software ................................14
The installation process ..........................................15
Starting the software..............................................16
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System requirements 
To ensure that the software will be able work with your computer, the following lists the 
minimum specifications required: 

 Pentium II 233MHz processor 

 64MB RAM 

 10MB free disk space 

 Windows 98, Windows Me, Windows NT, Windows 2000, Windows XP 

 Internet Explorer 5.0 or later 

 1 available serial port and/or 1 available USB port 

 800 x 600 screen resolution 

 256 screen colors. 

The recommended specifications are: 

 Windows 2000, Windows XP, or later 

 Internet Explorer 6.0 or later 

 65535 (16bit), or more, screen colors. 

 1024 x 768, or higher, screen resolution. 

If you are unsure of what your computer specifications are, please read the following 
section, which will help you locate the relevant information. 
 

Finding your computer 
specifications 
If you are unsure of your computer specifications you can find the relevant information by 
following these steps: 

1 To determine your computer CPU, RAM and version of Windows Operating system: 
 

a) Open the "Control Panel". This can be done by using the mouse to click on the 
Windows "Start" button, typically located in the bottom left of the screen, to open 
the Start menu. 

b) Once the "Start" button has been clicked, you will see a menu appear.  

c) If your menu looks similar to the following picture, click on the visible "Control 
Panel" item. 
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d) If your menu looks similar to the following picture, the "Control Panel" item is 

located within the "Settings" menu item. 
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e) Within the "Control Panel" window there is a "System" icon. For Windows XP users, 
you may need to "Switch to Classic View" to locate the "System" icon quickly. Start 
(open) the "System" icon once you have located it. 

f) Clicking on the "General" tab at the top of the "System Properties" window, which 
is usually the default, will display the relevant information for you about your 
system. 

 
2 To determine your screen resolution and colors: 

a) Open the "Control Panel" as explained in step 1. 

b) Open the "Display" item. 

c) Click on the "Settings" tab at the top of the "Display Properties" window will 
display the relevant information for you about your display. 
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d) From the "Settings" portion of the "Display Properties" window you will see your 
current screen settings and you may also be able to change some of your display 
settings if you want.  

 

3 To determine your spare hard disk drive space: 

a)  Open "My Computer" which is typically located on your desktop and/or within the 
Windows "Start" menu. 
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b) Using your mouse, click the button on the right over the drive that includes "(C:)" 
in its description. 

 

c) Select "Properties" (left mouse click) from the popup menu that will appear. 
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d) Clicking on the "General" tab at the top of the drive properties window will display 
the relevant information for you about your hard drive. 

 
e) If you have multiple (hard disk) drives installed on your computer you can repeat 

steps (b) through to (d) for each drive to get the same type of information. 
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Getting a copy of the 
software 
The software is available for download from the LogTag Recorders Internet site, 
www.logtagrecorders.com. LogTag Recorders does not charge for the download of the 
LogTag Analyzer software or for the updates to the LogTag Analyzer software. You are 
welcome to distribute copies of the LogTag Analyzer software freely and at your discretion 
as long as it is distributed in the packaged format as originally downloaded from the 
LogTag Recorders Internet site. 

When you visit the LogTag Recorders Internet site, follow the software navigation links to 
obtain a download link for the latest version of the LogTag Analyzer software. The request 
to download LogTag Analyzer software from the LogTag Recorders Internet site will result 
in an email automatically being sent to you with the download link for the latest version. 
To begin the actual download of the software process, click on the link provided in your 
email, and your email software will prompt you to save or open the file. 

 

We recommend choosing the option to save the file to your disk and to save the file to 
your desktop. If you are an experienced user you may wish to save the file to a different 
folder of your choosing. Once the installation process has been completed, this file can be 
safely deleted, as it is not required for using the software. 

There is only one file required to be downloaded to be able to install the software on your 
computer. Once the relevant installation file has been downloaded to your computer, you 
only have to open the file to begin the installation process.  
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The installation process 
To install the LogTag Analyzer software, first you need to locate the installation file that 
was downloaded from the LogTag Recorders Internet site. To begin the installation 
process open the installation file, which is typically performed by double clicking the left 
mouse button. 

Tip: Double clicking a mouse button, implies the user clicks the same mouse button in 
quick succession. 

The installation process will guide you through the relevant steps to correctly and 
successfully install the software. If you have installed any other software, you should find 
the installation process familiar. To proceed through each step of the installation process, 
click the "Next" button. If you want to change a previous step you can click the "Back" 
button. When the process is ready to be completed, clicking the "Finish" button, when it 
appears, will finish the installation process. If you want to stop installing the software, 
click the "Cancel" button.  

We recommend you leave all options to their default setting, especially if you are unsure 
of what option to select or what the actual implications are if the option was to be 
changed. 

During the installation process, a window similar to the following picture may appear. This 
is part of the process of installing the driver for the USB Interface. Clicking on the 
"Continue Anyway" button will allow the driver to be successfully installed. The chapter 
"Resolving USB Driver Problems", included later in this guide will guide you through 
the necessary steps to successfully install the driver for the USB Interface if the "STOP 
Installation" button was clicked. 
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Starting the software 
At the conclusion of the installation process, the final screen will provide you with an 
option to immediately start the LogTag Analyzer software. If the option "Start LogTag 
Analyzer after finished" is not visible, then you require other newer software, for example 
a newer version of Microsoft Internet Explorer, to be installed prior to the LogTag 
Analyzer software being able to successfully start.  

  

The installation of the LogTag Analyzer software will also provide you with two simple 
methods to start the LogTag Analyzer at a later time: 

1 A "Shortcut" on the desktop, which you can double click to start the software. 

 
2 A "Shortcut" in the "Start" menu system. 
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If you are using Windows XP, you may need to click on the "All Programs" item to 
locate the "LogTag Analyzer" shortcut, like in the following picture. 
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If you are not using Windows XP, you will find the "LogTag Analyzer" shortcut in the 
"Programs" menu, in a similar location to the following picture. 
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C H A P T E R  3  

Quick Start Guide 

You've got the software installed on your computer and now you want to use the LogTag, 
see how it goes and what it can do. This chapter will briefly cover the steps involved to 
get your LogTag ready to use, how to get it started and then retrieve the recorded 
information out of the LogTag. The subsequent chapters will explain in more depth these 
steps and the various options available to you. 

In This Chapter 

Connecting the Interface ........................................19
Using the LogTag with the Interface........................21
Get a LogTag ready for use ....................................23
Starting and using the LogTag ................................30
Retrieve information from LogTag ...........................31
 
 

Connecting the Interface 
There are two types of the Interface Cradle available. The first connects to the computers 
serial (RS232) communications port and the other connects to the computers USB 
(Universal Serial Bus) communications port. Although there may be multiple connectors 
on the computer for each of these types of communications ports, the shape of each is 
unique and therefore it is not possible to connect the Interface Cradle to the wrong type 
of communications port. The software supports the connection of multiple Interface 
Cradles at the same time and therefore as many serial and/or USB Interface Cradles as 
are needed and the computer supports may be connected. 

The connectors for the serial (RS232) communications ports typically look like the 
following picture. 
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Serial (RS232) communication ports can be typically found at the rear of the computer 
and there are usually at most two ports installed on a single computer. Most serial 
Interface Cradle connectors will have screws included on the plug and as such we 
recommend that these are tightened when the connector is plugged in so that it does not 
accidentally pull out during usage.  

The connectors for USB devices typically look like the following picture.  

 

Connectors for USB devices and the sockets on the computer where USB devices are 
plugged in will often display a USB logo nearby to help them be identified. Example 
pictures of the USB logos that may appear are: 

 

The sockets for the USB communication ports are typically located at the rear of the 
computer. In some computers there may also be two or more USB communication ports 
located on a front panel of the computer and/or on the top of the computer case. Please 
ensure that the software has been installed prior to connecting the USB Interface Cradle 
to the computer as the software installation also installs the drivers required to 
successfully connect and use the USB Interface Cradle. If you experience problems 
getting the software to find and identify a connected USB Interface Cradle then there may 
have been a problem during the installation of the software with the installation of the 
drivers that the USB Interface Cradle requires. The subsequent section resolving USB 
driver problems will guide through the steps necessary to resolve any problems with 
getting USB Interface Cradles working on the computer. 

If the computer is using the Windows NT® operating system, a USB Interface Cradle will 
not be able to be used, as Windows NT® does not support USB devices. 
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Using the LogTag with the 
Interface 
The LogTag fits into the Interface Cradle just like a putting a piece of bread into a toaster. 
As shown in the following picture, the LogTag faces towards the front label of the 
Interface Cradle with the contacts on the reverse side. If you look into the Interface 
Cradle slot, you will be able to see where the contacts connect with the matching contacts 
in the Interface Cradle. 

 

When placing the LogTag into the Interface Cradle slot, you should be able to feel a very 
slight resistance as the contacts "grab" the LogTag. This is normal. Removal of the 
LogTag will cause a slight clicking noise as the contacts snap back into their "unloaded 
position". 

If the LogTag has readings stored within its memory, the software will automatically start 
to download the data and will also display an animated picture during the download 
process, similar to the following picture. 
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The download process can be stopped by clicking on the "Cancel" button below the 
download animation or pressing the "Esc" key. 
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Get a LogTag ready for use 
To begin the process of preparing a LogTag to record information, first click the LogTag 
icon ( ) that is located on the toolbar, which will start the LogTag wizard. 

 

The LogTag wizard performs two distinct tasks: 

1 It finds the communication port (USB and/or Serial) that the LogTag is attached to 
through the Interface Cradle and retrieves the data that is stored within the LogTag, 
and 

2 It allows the LogTag that is currently connected and in the Interface Cradle to be 
prepared for its next use. 

The wizard is a key part of the software that is used for each of the steps.  

In This Section 

Welcome ...............................................................24
Locate LogTag(s) download and save relevant data .25
Configure LogTag(s) for next use ............................27
Prepare LogTag(s) for next use...............................28
 
 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



24 LogTag Analyzer  
 

Welcome 
First the Wizard has a welcome screen (this is "1" on the Action List). This asks you to 
make sure you have not neglected to place the LogTag firmly in the Interface Cradle.  

 
The Wizard is responsible for certain "Action Steps" and these are clearly listed at the left 
in the wizard window.  
 

To get to the next screen, click on  and the next wizard screen will appear. 
The green arrow will indicate you have moved to Step 2. 
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Locate LogTag(s) download and save relevant data 
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In this screen you will see one of the following pictures next to each of the items in the 
list: 

 (no picture) indicates the software is still using this communications port. 

  Data was successfully retrieved from the LogTag and stored/saved to disk. 

  Data was successfully retrieved from the LogTag but there was no need to save 
the information to disk. 

  The software was unable to detect an Interface Cradle connected to the 
communications port or was unable to detect a LogTag in the Interface Cradle. 

  The LogTag is a single use logger and cannot be prepared for use again and 
should therefore be returned to the supplying distributor or agent once you have 
finished with the LogTag. You will still be able to continue to retrieve information 
stored within the LogTag. 

The LogTag should be almost instantly recognized by serial number and the number of 
readings. It is possible to have and use more than one communication port at a time and 
if so, the wizard will find all the LogTags. 

The communication ports that are not in use (the ones that initially are reported with the 
 mark) can be removed from view by selecting an option. You don't have to do that 

now, but you can do it later to clean up the "wizard window" appearance. 

To get to the next screen, click on  and the third wizard step screen will 
appear. The software will automatically proceed to the next wizard step, as if the user 

clicked on , if each of the Interface Cradles detected have a LogTag detected 
in them and the information within the LogTag was successfully retrieved. 
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Configure LogTag(s) for next use 

 

The options are available so you have appropriate control over the way the LogTags will 
behave and store data for the upcoming period of recording. These options are explained 

in more detail in the chapter "Preparing LogTag for use". Click  to record 
the configuration data and you will see the final confirmation screen. 
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Prepare LogTag(s) for next use 
The last Wizard screen involves sending the new configuration data to each LogTag to 
prepare them for their next use. While the software is sending the new configuration data 
to each LogTag the top of the window will look similar to the following picture. The 
process of sending the new configuration data to each LogTag should take less than 20 
seconds in total to complete. 

 

Once the software has finished uploading the updated configuration information into each 
LogTag, the window displaying the progress will look similar to the following picture. 
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In this screen you will see one of the following pictures next to each of the items in the 
list: 

 (no picture) indicates the LogTag is still in the process of being prepared for its next 
use. 

  The LogTag was successfully prepared for its next use. 

  The LogTag failed to be prepared for next use. Press to try again. 

  The battery within the LogTag is low and is unlikely to have enough capacity to 
record all the data you want during its next use. In this situation the LogTag should no 
longer be used. 

When all LogTags have finished receiving their new configuration data, click  
to close the wizard. Your LogTag(s) are now ready to be started and used. 
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Starting and using the 
LogTag 
Once a LogTag has been successfully configured for use it is ready to be started. To start 
a LogTag simply press and hold the START MARK button on the LogTag until both the OK 
and Alert lights alternately flash on and off.  

You can also have the LogTag record an "inspection" mark at any time while it is 
recording, simply by pressing and holding the START MARK button on the LogTag until 
both the OK and Alert lights flash on and off at the same time. You may have the LogTag 
record as many inspection marks as you want while it is recording, however only one 
inspection mark can be recorded per reading. In other words, if your LogTag is configured 
to take readings at 15 minute intervals, inspection marks can be recorded at intervals of 
15 minutes or more. If the LogTag has finished recording then pressing the START MARK 
button will have no effect until after the LogTag has been prepared for next use. 

The red light on the LogTag, also called the Alert light, will regularly flash to indicate that 
a preset alert condition has been met and/or exceeded.  

While the LogTag is recording after being started, the green light on the LogTag, also 
called the OK light, will regularly flash every 4 seconds to indicate that it is still recording. 
Once the LogTag has finished recording the green light will regularly flash every 8 
seconds. However, if a preset alert condition has been met and/or exceeded then only the 
Alert light will flash, even if the LogTag has finished recording. 
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Retrieve information from 
LogTag 
When you ready to view the recordings that are stored within the LogTag, just place the 
LogTag into the Interface Cradle as before. If the LogTag is still recording when you go to 
retrieve the readings it will continue to record without interruption so you will be able to 
download again later if you choose. 

If the LogTag has readings stored within its memory, the software will automatically start 
to retrieve a copy of the recording contained within the LogTag and will also display an 
animated picture during the download process, similar to the following picture. 

 

Once the readings have been successfully retrieved from the LogTag(s), the software will 
display the information for you. The chapter "Results from LogTag" explains in more 
detail the information that is displayed to you as a result of retrieving the recorded 
readings from LogTag(s). 
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C H A P T E R  4  

Preparing LogTags for use 

Before you can use a LogTag to monitor and record environmental conditions you must 
first prepare it for use. The process of preparing a LogTag for use allows you to define a 
number of parameters, including: 

 How long it should record the environmental condition for, so that you can be assured 
that it will record for the duration of time required. For example, if you want it to 
monitor a shipment that will take 10 days to deliver, you will be able to make sure it 
will record the humidity and/or temperatures throughout the entire 10 day period. 

 How often it should record the environmental conditions. 

 Under what conditions it should display an alert. An alert indicates when the 
environmental condition being recorded is not within set limits. 

This chapter explains how to prepare a LogTag for use and what the options mean. 

In This Chapter 

Getting a LogTag ready use ....................................34
Restricted Access Requirements ..............................35
Preparing LogTag for next use ................................36
Verify Access Password...........................................40
Pre-start data collection..........................................41
Continuous operation .............................................41
Working with batches of LogTags............................42
Getting the best from your LogTag..........................43
Prolonging battery life ............................................44
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Getting a LogTag ready 
use 
There are two ways to prepare a LogTag for use, both of which will achieve the same 
result. Once a LogTag has been through the configuration process to get it ready for next 
use, any readings previously recorded will no longer be available for retrieval. 

1 Click the LogTag icon ( ) on the toolbar or the "Wizard..." menu item located in the 
LogTag menu. 

 
This is the safest option, as it will retrieve any readings that are stored within the 
LogTag and save them to disk before getting the LogTag ready for next use. This 
option is useful when you are unsure whether or not the readings stored within the 
LogTag have been previously retrieved and saved to disk. 

2 Click the "Configure..." menu item located in the LogTag menu. 

This is the quickest option, as it does not involve the step that retrieves any readings 
that are stored within the LogTag. This option is useful when you know you have 
previously retrieved the readings or you no longer need a record of the readings that 
are currently stored within the LogTag. 

The wizard will appear once you have selected the option of your choice to guide you 
through the necessary steps to prepare a LogTag for next use. While the wizard is visible 
the "Automatic download" feature will be disabled. 
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Restricted Access 
Requirements 
Every LogTag supports an option that, when enabled, results in users being required to 
provide the correct password to gain further access to the LogTag. When the restricted 
access option is enabled, a window similar to the following picture will be displayed 
allowing the user to enter the correct password. 

 

The relevant process and/or wizard will only continue successfully if the correct password 
is supplied by the user. Passwords are case sensitive and therefore the passwords "Bob" 
and "bob", for example, are different. 
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Preparing LogTag for next 
use 
The "Configure LogTag(s) for next use" step provides you with all the options that can be 
configured to effect how a LogTag records data during its next use. Once the changes 

within this screen have been made, if any, click  to send the configuration 
information to the LogTag(s).  

 

The following table describes each configurable option that is permitted to change. 

Function Purpose 

User ID This can be used for identification of the load in transit to be 
monitored, or simply an identifier that describes the purpose of the 
monitoring. Bill of Loading information, Shipper, commodity, 
contact name and other relevant information can be placed here. 
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Enable pre-start logging Pre-start logging is a feature that protects the recording in the 
event of a failure to actually press the START MARK button to 
initiate the recording. It is an insurance policy against the loss of 
critical data. This is almost always checked for transit monitoring 
applications. This option is further explained in the section "Pre 
start data collection". 

Record readings 
continuously, overwrite 
oldest when memory 
full 

This is what is called a “data wrap” in which the recorder just keeps 
writing data to memory. It is a “moving window” of data. For 
example, this is useful for fixed base MKT monitoring with the 
interval set to one year, so that the current “yearly MKT” can 
always be in the memory of the LogTag. If this option is selected, 
the user will be “opted out” of the next two options. This option is 
further explained in the section "Continuous operation". 

Record readings so 
that: 

If this is selected, the logger stops logging when the number of 
data points has been gathered and stored in memory that spans at 
least the number of days specified below. When this option is 
selected, the following two options will determine the number of 
data points over the span of time that will be recorded. 

Readings recorded will 
span at least X days 

If you know how long you want to record, the Configuration screen 
will automatically set the number of readings to be collected at a 
particular interval. This setting will only have an effect if the above 
option "Record readings so that:" is selected. 

Number of readings to 
record X maximum is Y 

This data box will display the calculated number of readings if you 
select a time span and an interval. Alternatively, you can select the 
number of readings desired, and the time span will be altered 
based on the interval. If this is selected, the logger will stop logging 
when the number of readings has been gathered and stored in 
memory. "Y" represents the maximum number of readings the 
LogTag can store, however with a selected interval and a selected 
time span, you may not need to use all of the available data space. 
This setting will only have an effect if the above option "Record 
readings so that:" is selected. 

Record a reading every 
X  

This determines how frequently the LogTag records the 
environmental humidity and/or temperature into its internal 
memory. 

Begin recording after a 
delay of X 

Determines how long after the START MARK button on the LogTag 
has been pressed that it will actually begin to record the 
environment humidity and/or temperature. This feature is useful for 
example, when the LogTag could falsely trigger an alert because 
the environmental conditions it is being started in is quite different 
to the environmental conditions to be monitored. If pre-start 
logging is enabled, the LogTag will continue to record pre-start 
readings during this delay. 

Enable the OK (Green) 
indicator 

This determines whether or not the green light should function 
while the LogTag is recording after being started. 

Humidity / Temperature These tab controls will allow the humidity and temperature alert 
conditions to be configured independently. These tab controls will 
only appear when configuring a LogTag that has a humidity and a 
temperature sensor. If the LogTag has only one sensor then the 
following alert conditions will apply to that sensor. 
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Enable the Alert (Red) 
indicator when 

This determines whether or not the red light should function when 
an alert condition has been detected. An alert occurs when one or 
more of the following conditions have been met. When an alert 
condition has occurred, this indicator will flash at a regular interval. 

Readings below X or 
above Y 

You can set the upper threshold limit and lower threshold limit by 
entering the appropriate information in the boxes. If the reading 
does not go below X or above Y then the alert indicator will not 
activate. 

After X consecutive alert 
readings (W minutes) 

This feature allows the user to specify the condition that will trigger 
an alert. Note that the number of minutes shown will depend on 
the number of alert readings you enter into the box AND the 
recording interval already specified. For example, if X is 3 and two 
readings are above the upper threshold limit but the subsequent 
reading is below the upper threshold limit and still above the lower 
threshold limit then the alert indicator will not activate. 

After X alert readings 
have occurred (W 
minutes) 

This feature allows the user to add an additional “or” type of 
condition to trigger an alert. You may want to add up the total 
number of alert readings in addition to or instead of consecutive 
readings. An example of the use of this feature is included later in 
this section. 

Leave alert indicator 
enabled even if 
readings return within 
alert range 

If this option is enabled then the alert indicator will remain active, 
even if the current reading does not meet the alert conditions 
specified by the previous controls. 

If this option is disabled then the alert indicator will remain active 
only if the current reading meets the alert conditions specified by 
the previous controls. 

Clear and reset alert 
when START MARK 
button pressed 

This feature will turn off any active alert whenever the START 
MARK button is pressed on the LogTag. It will also reset the 
internal alert counters such that it would be as if no alert condition 
had occurred at all while the LogTag was recording. 

If however, the LogTag has finished recording all the readings, 
pressing the START MARK button will not clear and reset any active 
alert.  

If the LogTag being configured does not support this feature, this 
feature will be disabled and therefore its setting cannot be 
changed. 

Configure requires a 
password 

This feature allows the user to define a password that must be 
provided to configure the LogTag next time. If this option is 
enabled and the password changes, the user will be required to 
verify the new password when the wizard progresses to the 
next step. Passwords are case sensitive and therefore the 
passwords "Bob" and "bob", for example, are different. 
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When the Alert (Red) light on the LogTag flashes it means that a preset alert condition 
has been exceeded. These configuration options allow you to determine how many 
readings above or below selected limits are required for an alert on the LogTag to be 
triggered. These can be set for consecutive readings beyond the limits and/or total 
readings beyond the limit. So, if the red light is flashing, its meaning is based on how the 
LogTag has been programmed.  

For example, we may have configured a LogTag to flash the alarm if there were 5 
continuous out-of-range readings or 7 total out-of-range readings. 

 

This would yield the following response: 

What happened Result 

2 out-of-range, return to normal, 2 out-of-
range, return to normal, 2 out-of-range, 
return to normal 

No Flashing Red Alarm Light 

4 out-of-range, return to normal, 4 out-of-
range 

Flashing Red Alarm Light 

4 out-of-range, return to normal, 2 out-of-
range 

No Flashing Red Alarm Light 
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In the first instance, the alert criterion is NOT met because the total out-of-range events 
equals 2 + 2 + 2 = 6. The alert condition is 7 total, so the alert does not go off. 

In the second instance, the alert criterion is met because the total out-of-range events 
equals 4 + 4 = 8. The alert condition is 7 total, so the alert DOES go off. 

In the third instance, the alert criterion is NOT met because the total out-of-range events 
equals 4 + 2 = 6. The alert condition is 7 total, so the alert does not go off. 

Matching these to known conditions of interest in your monitoring program may require 
some information about the effects of exposure to different durations of out-of-range 
humidity and/or temperatures. 

 

If the battery within the LogTag is detected to be low and therefore not recommended for 
further use, the software will display a warning to you in the top right corner, like the 
following example. 

 
 

Verify Access Password 
When configuring a LogTag for its next use, if the user enables the "Configure requires 
a password" option and/or changes the password to restrict access to the LogTag, then 
the user is required to verify the password to be defined before it will be stored in the 
LogTag. The window that will appear to verify the password will be similar to the 
following picture. 
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Once a password has been stored in the LogTag, further access to it can only be achieved 
by providing the correct password. Therefore, if a password is forgotten further access to 
the LogTag will not be possible. Passwords are case sensitive and therefore the 
passwords "Bob" and "bob", for example, are different. 
 

Pre-start data collection 
The LogTags support a feature called "pre-start logging", which can be selected during 
configuration. 

When pre-start logging is enabled the LogTag will automatically start logging as soon as 
configuration is completed. It will record at the same sampling interval as defined in the 
configuration and will continue to record until the user starts the LogTag by pressing the 
START MARK button on the LogTag. Once the LogTag has been started, it will record as 
per the configuration settings. While the LogTag is recording pre-start readings the Alert 
LED on the LogTag will not activate if an alert condition is detected. 

Pre-start logging is useful as a fail-safe recording setting so if the LogTag is not started at 
the appropriate time, the readings will still be available to view later. 

When the readings are retrieved from the LogTag, any pre-start readings will be identified 
as pre-start readings so the user can quickly identify the readings recorded before and 
after the LogTag was started. 

All LogTags have a finite amount of memory to store the readings it records. Therefore, 
while the LogTag is recording pre-start readings the LogTag will operate in its 'continuous 
operation' mode, which is explained further in the section "Continuous operation". 
Once the memory within the LogTag is full the oldest pre-start reading will be overwritten 
with the latest reading recorded, regardless of whether the reading recorded is a pre-start 
reading or a reading to be recorded after the LogTag has been started. 
 

Continuous operation 
All LogTags have a finite amount of memory to store the readings that are recorded. 
When the LogTag is recording readings continuously it will not stop once the memory 
within the LogTag is full of readings. Rather it will replace the oldest reading stored within 
the LogTag with the latest reading so that only the most recent readings are maintained 
in the LogTag memory.  
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Working with batches of 
LogTags 
You may find that at some stage you need perform a similar task on multiple LogTags, 
whether it is retrieving readings stored within the LogTags and/or preparing them for 
their next use. The LogTag Analyzer software has been designed to make the effort 
involved with multiple LogTags as simple as possible. 

To retrieve a copy of the recorded readings stored within multiple LogTags, simply insert 
each LogTag to download into the Interface cradle. The software will then automatically 
retrieve the recorded data from the LogTag, save it to disk and then display the 
information for you. Therefore, you will be able to retrieve the recorded readings stored 
from within one or more LogTags without needing to interact with the software and/or 
computer. 

To prepare multiple LogTags for use you can use the "Wizard..." or the "Configure..." 
wizard, available in the "LogTag" menu, depending on whether or not you want to 
retrieve and save a copy of any readings recorded within the LogTags you are about to 
use. Simply prepare the first LogTag(s) as per usual and at the conclusion of the last step 
remove the LogTag(s) from their Interface Cradle, place the next LogTag(s) to be 

prepared for their next use into an Interface Cradle and click . Therefore, you 
will be able to prepare multiple LogTags for use with minimal interaction with the 
software and/or computer. 
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Getting the best from your 
LogTag 
Many users of humidity and/or temperature loggers are used to attaching the logger to a 
hook or tie-wrapping them to a monitored object. A wide variety of attachment methods 
can be used with the hole on upper right hand corner of the LogTag, such as bolting the 
LogTag in position, attaching it to a packaging strap, using a car-seal for security or other 
means. 

The hole is quite strong, so most means of attachment will not compromise the structural 
integrity of the LogTag. We do, however, recommend that the dead weight stress on the 
hole itself not exceed 5 pounds (2 Kg). 

The sensor for the LogTag is also very responsive, so we recommend you position the 
LogTag in a location, where it will not be susceptible to changes in temperature due to 
operational activities. For example, it is not recommended you place a LogTag beside a 
door way, as every time someone passes through the door, the LogTag will register the 
change of environmental temperature due to the breeze that will be generated by the 
person, which does not necessarily reflect the overall temperature of the environment 
been monitored. 
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Prolonging battery life 
If your LogTag is not going to be used for extended periods of time, it may be worthwhile 
to set the LogTag into "Hibernation" mode. In "Hibernation" mode the LogTag will 
consume minimal power, which will extend the battery life when compared with leaving 
an idle LogTag in operating mode. 

While a LogTag is in "Hibernation" mode it will: 

1 Not be able to record and store any new readings. 

2 Not activate the Alert and OK lights. 

3 Not respond to the START MARK button being pressed. 

To return a LogTag from "Hibernation" mode to normal operating mode so that it can 
record and store new readings, go through the usual process of preparing it for next 
use. 

To set a LogTag to "Hibernation" mode, select the “Hibernate...” menu item in the 
“LogTag...” menu. 
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The following example illustrates using the "Hibernation" feature. 
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In this screen you will see one of the following pictures next to each of the items in the 
list: 

 (no picture) indicates the LogTag is still in the process of being set to "Hibernation" 
mode. 

  The LogTag was successfully set to hibernation mode. 

  The software was unable to set the LogTag to hibernation mode. 

Once a LogTag has been successfully set to "Hibernation" mode it should be removed 
from the Interface Cradle before pressing any other button. As soon as the software 
communicates with a LogTag in "Hibernation" mode, for example through automatic 
download, Hibernation, etc, it will be returned to normal operating mode. 

The extent to which the Hibernation mode will prolong the battery life of a LogTag may 
vary between different models and versions of LogTag products. 
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C H A P T E R  5  

Results from LogTag 

The LogTag stores the recorded readings in its internal memory. Since the LogTag 
contains the recorded readings in its internal memory, you must use the LogTag Analyzer 
software to extract the information from the LogTag through the Interface Cradle and into 
a format that can be displayed to you in a meaningful way. It is usually very important 
that the information retrieved from a LogTag is retained. The software will automatically 
save the information retrieved from a LogTag to your disk drive so that you can view the 
information at a later date, a useful feature if you require traceability. This chapter 
explains how you can retrieve the recorded information stored within a LogTag and have 
the software display it to you on the screen in a meaningful way. 

In This Chapter 

Getting results from LogTag....................................48
Understanding the results .......................................49
Inspecting the information at close range ................50
Manual scaling of the chart .....................................55
Chart annotations...................................................57
Chart subtitle .........................................................59
Combining charts onto a single chart.......................61
Automatically calculated statistics............................62
Displaying statistics ................................................66
Printing the results .................................................66
Sending a file by email direct from Analyzer.............67
Calling up previous results ......................................68
Digital signatures ...................................................70
How secure is my data ...........................................72
Viewing file properties ............................................73
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Getting results from 
LogTag 
You can retrieve the recordings from LogTag(s) as many times as you require. The 
process of retrieving data stored within a LogTag does not erase it from the LogTag's 
memory. If the LogTag is currently recording while you retrieve the information, it will 
continue to record without interruption. 

There are three ways to retrieve the recorded results from a LogTag.  

1 While the LogTag Analyzer software is open (does not need to be the currently active 
software), simply slot the LogTag into the Interface Cradle. If the automatic download 
feature is enabled, the software will automatically retrieve the recorded readings, save 
the information to your disk drive and display the information to you. While the 
software is automatically retrieving the readings you will see an animated picture 
appear, similar to the following picture. 

 

2 Click the "Download..." menu item located in the LogTag menu. 

 

 
This is the second quickest option, as it does not include the steps involved in 
preparing the LogTag(s) for their next use. 

3 Click the LogTag icon ( ) or the "Wizard..." menu item located in the LogTag menu. 

This option will allow you to prepare the LogTag for its next use after retrieving the 
readings stored within the LogTag. If you do not need to configure the LogTag for its 
next use now, the previous option described may be preferred as it will not involve the 
configuration steps and therefore be a quicker and simpler method. 
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The wizard will appear once you have selected the appropriate option of your choice to 
guide you through the necessary steps to retrieve the recorded readings. While the wizard 
is visible the "Automatic download" feature will be temporarily disabled. You will not be 
able to access any of the Wizards while an "Automatic download" is in progress. 
 

Understanding the results 
The Data Screen is an all purpose data display. The window appears inside the main 
LogTag Analyzer window, and has a series of tabs along the bottom. Each of these tabs 
changes the Data Screen display.  

 

The different display types are: 

Chart A display of the data in a time versus humidity and/or temperature 
chart. 

Data A listing (spreadsheet style) of the time versus humidity and/or 
temperature data. 

Summary A summary of the data, including averages, ranges, alert results, 
LogTag identification data, and other information. 

Pre-Start Chart A chart of data stored by the LogTag prior to it being started. 

Pre-Start Data A listing of the data stored by the LogTag prior it being started. 

Pre-Start Summary A summary of the data stored by the LogTag prior to it being started. 

All Chart A chart of the all of the data stored in the LogTag including the data 
prior to it being started and after being started. 

All Data A listing of the all of the data stored in the LogTag including the data 
prior to it being started and after being started. 

All Summary A summary of the all of the data stored in the LogTag including the 
data prior to it being started and after being started. 
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The screens that are typically used are the first three (Chart, Data and Summary), since 
they represent the normal usage of the LogTag. The other Data Screens are included to 
deal with situations where the LogTag may have not been activated due to user error; the 
data is still collected and available. LogTags may be handled by those who are unfamiliar 
with the start feature. The “pre-start logging” feature protects against accidental “no 
starts” to preserve data that may be valuable. 

In some cases, not all the "tabs" previously described will be displayed, for example you 
may only see Chart, Data and Summary. If the LogTag has been configured to not record 
any pre-start data, the downloaded data will not display any; you will only see the data 
that has been set up in the “configured mode” and recorded after starting the LogTag. 
Pre-start recording is an option, not a default. Also if the LogTag was configured to record 
continuously and the data has wrapped in memory all the pre-start data would have been 
replaced with more recent data and as such there will be no pre-start data left to display. 
 

Inspecting the information 
at close range 
When a file is displayed either from downloading or from calling up a stored data file, the 
file typically appears as a chart. It might look something like this: 
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The display does not show all of the available data points. For more detail, you can zoom 
in and display just one small section of the charted data. Using the mouse, find the upper 
left corner of a window of interest, hold down the left mouse button, and move the 
mouse to the bottom right corner. The zone of interest will be highlighted. 
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The highlighted zone is immediately displayed after the left mouse button is released on 
the maximum displayable resolution: 
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This display now shows the maximum detail from the highlighted area.  

When this mouse operation has been completed, for example, a picture of the highlighted 
area can be placed on the clipboard. This picture can be then be pasted into any Microsoft 
Windows® application. For example, if you are writing a letter and want to illustrate a 
point based on chart data from a LogTag, you can paste the picture of the chart directly 
into the letter. 

When the mouse pointer is moved over the chart, a small window (tooltip) is displayed 
near the mouse pointer. It displays the reading closest to the mouse pointer position. If 
the readings are very close together, it is a good idea to zoom in to an area of interest to 
inspect individual readings with the help of tooltips.  

Whenever the data displayed on the chart has been zoomed in to show more detail and is 
showing only a portion of the charted data, if you click on the corresponding Data tab you 
will see that only the readings shown on the chart are currently displayed. If you also click 
on the corresponding Summary tab you will see an additional section of statistics that 
have been calculated based on only the portion of readings currently being shown on the 
Chart screen. Following is an example of the additional section of statistics that will 
appear within the Summary Screen when a section of the readings within the Chart 
screen have been zoomed in. 
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The Zoom Out ( ) command in the Edit menu or on the toolbar can be used to revert 
the display back to showing the range of data points that were showing prior to the new 
zoom section being selected. 

Inspection marks are recorded each time the START MARK button is pressed on the 
LogTag. Each inspection mark is numbered and can be identified by counting the number 
of marks on the Chart display. If you click on the corresponding Summary tab and scroll 
down in the data record you will see a summary of all the points that were recorded 
between each subsequent inspection mark. Following is a picture of a portion of a 
Summary Screen showing the relevant information for the sequence of data points 
between the inspection mark #2 and inspection mark #3. 
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Manual scaling of the 
chart 
By default, each chart is initially displayed zoomed to the range of readings. This setting 
can be changed in the Options dialog (see chapter “Charts”). 

To change the temperature and humidity scale, or select a range of readings by time and 
date, select “Manual Scaling” from the chart popup context menu.  

The following dialog will be displayed: 
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Range of sensor The chart is zoomed to the minimum and maximum values for 
each sensor. 

Range of readings The chart is zoomed to the minimum and maximum reading 
values. 

Manual Scaling This option lets you specify the date/time range, temperature and 
humidity ranges (if applicable) for the chart display. The dialog 
shows the current zoom settings. 

Click  to apply your selected settings.  

To return to the previous zoom level, use the Zoom Out ( ) command in the Edit menu 
or on the toolbar.  
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Chart annotations 
To include more information in your chart you can add chart annotations. These will be 
displayed and printed with your chart. 

Click the right mouse button at the location where you want to add the annotation. Select 
“Add Annotation” from the popup context menu. Enter the annotation text and click 

. The annotation will be displayed in the chart. When you zoom the chart 
display, the annotation will be zoomed with the chart readings. 
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To edit an annotation, move the mouse pointer into the area of an existing annotation. 
Click the right mouse button and select “Edit Annotation” from the popup context menu. 

Edit the text and click  to display the edited annotation.  

To delete an annotation, move the mouse pointer into the area of an existing annotation. 
Click the right mouse button and select “Delete Annotation” from the popup context 
menu. The annotation will be deleted.  

To delete all annotations, select “Delete All Annotations” from the popup context menu. 
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Chart subtitle 
The chart subtitle is displayed and printed underneath the chart title. 

To edit the subtitle, right-click on the area above the chart and select “Edit Chart Subtitle” 
from the popup context menu. 
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Enter or modify the text, then click  to display the edited subtitle. To remove 

the subtitle, delete the text in the Edit Chart Subtitle dialog and click . 
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Combining charts onto a 
single chart 

To overlay multiple charts in one view, select the Multi Chart ( ) command. All charts 
that are currently open will be displayed together. Additional files opened while in Multi 
Chart mode (including data downloaded from LogTags) will be added to the display. 

 

Each of the individual charts will be displayed with a letter symbol to allow you to tell 
them apart. The legend contains an entry for each chart showing the chart name and the 
corresponding letter. 

You can change the background colour for the Multi Chart display in the Options - Charts 
dialog.  

To remove charts from the Multi Chart display, use the Single Chart ( ) command to 
switch to Single Chart mode, then close the files you don't want to display. Select the 
Multi Chart ( ) command to switch back to Multi Chart mode. 

You will notice that the Data and Summary tabs are not available in the Multi Chart 
display. If you require additional information about the chart data, select Chart 
Statistics, which will be displayed separately for each chart. 

 

 

 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



62 LogTag Analyzer  
 

Automatically calculated 
statistics 
When a file is displayed either from downloading or from calling up a stored data file, the 
software will automatically calculate and display some statistics about the recorded data. 
The statistics that are calculated are shown on the corresponding Summary tab and are 
also calculated for each sequence of data points between the inspection marks. 

In This Section 

Average Reading....................................................62
Standard Deviation.................................................63
Mean Kinetic Temperature ......................................64
Degree Minutes......................................................65
 
 

Average Reading 
The Average Reading is the arithmetic mean of the sequence of data points. It is 
calculated by adding all the data point values together and then dividing the total by the 
number of data points. Mathematically this formula can expressed as illustrated in the 
following picture: 

 

Where: 

av the calculated arithmetic mean 

n the number of data points to include in the calculation 

ti a data point to include in the calculation 

For example, if there were 5 data points to calculate the arithmetic mean of and they 
were, 12.3, 15.9, 16.2, 14.7, 14.9, then the arithmetic mean would be 14.8. 
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Standard Deviation 
The standard deviation is a useful for determining how spread out the readings are from 
the arithmetic mean (Average Reading). Most controlled environments typically try to 
keep the environmental conditions at a stable and consistent humidity and/or 
temperature. The standard deviation can be used to help indicate how stable the 
environmental conditions were maintained. One standard deviation (sometimes expressed 
as "one sigma") away from the mean, positive or negative represents approximately 68 
percent of all the readings. Two standard deviations, or two sigmas, away from the mean 
represents approximately 95 percent of the readings. Three standard deviations represent 
about 99 percent of the readings. 

For example, if the arithmetic mean of the readings was 50.6°C and the standard 
deviation was 2.3°C, then approximately 68% of the readings were between 48.3°C and 
52.9°C, 95% of all the readings were between 46.0°C and 55.2°C and 99% of the 
readings were between 43.7°C and 57.5°C. Further more, if all the readings were 
recorded over a span of 1 day (24 hours) then the temperature was between 48.3°C and 
52.9°C for approximately 16 hours and 19 minutes during the recorded period of time. 

Mathematically the formula for calculating the standard deviation can expressed as 
illustrated in the following picture: 

 

Where: 

s the calculated standard deviation 

n the number of readings to include in the calculation 

av the calculated arithmetic mean 

ti a reading to include in the calculation 

For example, if there were 5 readings to calculate the standard deviation of and they 
were, 12.3, 15.9, 16.2, 14.7, 14.9, then the standard deviation would be 1.54 
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Mean Kinetic Temperature 
There are some products and materials that exist which have accelerated rates of 
degradation at higher temperatures. For example, perishable food items, pharmaceutical 
products and many forms of bacteria can grow/degrade exponentially as the 
environmental temperature increases. Mean kinetic temperature is a calculation that 
accommodates the non-linear thermal effect temperature can have on products. Mean 
kinetic temperature is represented as the equivalent temperature the product was 
thermally subjected to during the period of time the various temperature reading were 
recorded. 

Mathematically the formula for calculating the mean kinetic temperature can expressed as 
illustrated in the following picture: 

 

Where: 

mkt Mean kinetic temperature, in degrees Celsius 

 the activation energy. LogTag Analyzer uses an 
activation energy value of 83.144 KJ/mol for the 
calculation. 

 R the universal gas constant, which is 0.0083144 KJ/mol K 

 n the number of data points to include in the calculation 

 ti a data point to include in the calculation, in degrees 
Celsius 

For example, if there were 5 data points to calculate the mean kinetic temperature of and 
they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees Celsius, then the mean kinetic 
temperature would be 14.9 degrees Celsius. 
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Degree Minutes 
There are some products and materials that exist which can change their characteristics 
and/or degrade if they experience temperatures which are not within ideal conditions for 
long enough. For example, some products may experience freezer burn if they experience 
an extremely cold condition or experience a colder than ideal temperature for long 
enough period of time. Other products for example, ice cream, change their 
characteristics if they experience temperatures which allow it to melt. The LogTag 
Analyzer will automatically display the results of two separate Degree Minutes 
calculations. The result of the first Degree Minutes calculation displayed will be based on 
the readings that were recorded below the ideal conditions and the result of the second 
Degree Minutes calculation displayed will be based on the readings that were recorded 
above the ideal conditions. The ideal conditions used in the calculation of the Degree 
Minutes formula are based on the upper and lower alert values that where configured 
when the LogTag was originally prepared for use. 

 

Mathematically the formula for calculating the degree minutes above alert can be 
expressed as illustrated in the following picture: 

 

Where: 

degmin Total Degree Minutes spent above/below the alert 
threshold. 

ti The temperature that was above/below the alert threshold. 

a The alert temperature threshold. 

s The duration of time, in minutes, the temperature was 
sustained. 

For example, if there were 5 data points to calculate the degree minutes of and they 
were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees, each of these temperatures were recorded 
at 2 minute intervals and the high alert temperature threshold was 12.6 degrees, then the 
degree minutes temperature above the upper alert threshold would be 22.6 degree-
minutes. 
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Displaying statistics 
The statistics displayed on the Summary tab can be configured in the Options dialog. 
Refer to the  (see chapter “Summary Statistics”). By default, all statistics are displayed 
on the Summary tab. 

Statistics can also be displayed on the chart, underneath the legend. See chapter “Chart 
Statistics” for more information about configuring the chart statistics 
 

Printing the results 
Printing from LogTag Analyzer is slightly different to printing from other common 
Windows software, as the printer functions in terms of range of information to print rather 
than range of pages. This technique allows you to focus on what you want printed rather 
than the pages showing the information. 

You can choose to print all of the information, select a range of dates and times to print 
from or select a range of "inspection" marks. This could be a very important for transit 
monitoring since post trip and pre-event data are not significant to a discussion or dispute 
centering on a humidity and/or temperature maintenance issue. 
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The print window can be brought up by simply clicking once on the "Print" icon ( ) 
located on the toolbar or by clicking the "Print..." menu item from within the File menu. 

 
 

Sending a file by email 
direct from Analyzer 
You can send files of interest to another person, by email, directly from the software 
without the need to exit to your email software or to deal with file attachments. 

While you have the file of interest open and being displayed on the screen, just click once 
on the "Send Mail" icon ( ) located on the toolbar and your email software will pop up 
with the file already inserted as an attachment. Type the desired email address to send 
the file of interest to, add any message that you wish to include, and then click "Send". 
That is all. 

Clicking the "Send..." menu item within the File menu will achieve the same results as 
clicking the "Send Mail" icon as previously described. 

Note, the recipient of the file will also need to have a copy of the LogTag Analyzer 
software to open and view the file that you sent. LogTag Analyzer software is free and 
can be downloaded from the LogTag Recorders Internet site, www.logtagrecorders.com. 
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Calling up previous results 
The files that have most recently opened and displayed are listed towards the bottom of 
the "File" menu. To open other files, click the "Open" icon ( ) located on the toolbar, 
which will display the "Open" file dialog similar to the following picture and allows the 
user to locate and open one or more files of interest. 
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Clicking the "Open..." menu item within the File menu will achieve the same results as 
clicking the "Open" icon as previously described. 

After the software has been installed for the first time, there are two recently opened files 
listed in the "File" menu, even though no files have been opened yet. These are sample 
files, which were installed along with the software so that users can see an example of 
information that can be retrieved from LogTags. These files are not required for the 
correct operation of the software and therefore may be deleted at any time. 

If the software is unable to open the file, it will display an error similar to the following 

picture. Clicking on  will being the process of checking the Internet for an 
updated copy of the software. 
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Digital signatures 
Support for digital signatures is primarily provided for compliance with the US FDA 21 CFR 
Part 11 regulation - Electronic records and electronic signatures. Various industries 
however, may find inclusion of digital signatures beneficial towards their quality control 
and assurance systems. 

Digital signatures allow users to include their digital signature within a LogTag Analyzer 
file along with a meaning/reason for the inclusion of the digital signature. To add digital 
signatures to LogTag Analyzer files, the copy of the LogTag Analyzer software being used 
must be connected to the LogTag User Server software. For more information about how 
to get the software to connect to the LogTag User Server software see the "User Server" 
set of options settings and/or contact your local network administrator. 

While the file that the digital signature is to be added to is open and currently selected, 
add a digital signature by clicking on the "Digital Signatures" icon ( ) located on the 
toolbar, which will display the "File Properties" dialog with the "Digital Signatures" tab 
already activated, similar to the following picture. 
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Then click  to begin the process of adding a digital signature to the file. If 

 is disabled, moving the mouse pointer over  and leaving it still for 
a short time will revel the reason why the button is disabled. 

Once the "Add Digital Signature" dialog is visible, enter your LogTag Analyzer user 
password and the select the meaning for the digital signature that is being added.  

 

Click  to permanently add the digital signature to the file or  to not 
add the digital signature. Multiple digital signatures from the same and/or different users 
to LogTag Analyzer files may be added to a single file. 
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How secure is my data 
All LogTag files are encrypted and contain checks to detect if the file has been tampered 
with since it was originally created. If the software detects that a file has been tampered 
with, even by only one character or has become corrupted and therefore the data within 
does not represent the data originally retrieved from the LogTag, the software will not 
open the file and display the information within. 

An additional validation and security feature of the LogTag is that it will automatically 
insert error detection codes periodically during recordings, which are used to detect 
corruption or manipulation of data. Whenever these detection codes for a block of 
recordings fails its integrity validation test, the relevant readings become marked as non 
validated readings. Non validated readings are displayed differently to validated readings 
to indicate that they have failed their integrity test.  

Non validated recordings typically occur in the scenarios following scenarios: 

1 One or more readings within the non validated block of readings is not the genuine 
recorded value. 

2 The LogTag has been configured to perform continuous recordings and once the 
memory within the LogTag has been fully used, will cause older recordings to be 
overwritten, which will thereby invalidate the error detection code and integrity check 
for the block of readings the older recordings been overwritten exist within. In this 
scenario, it is not a problem that these recordings are non validated, rather it means 
that the particular block of recordings has only the validation and integrity protection 
offered by the communications between the LogTag and the computer system, which 
is typically the same, if not better than the level of protection offered by every other 
brand of logger available in the global market, that LogTag Recorders know of. 

3 A communications or hardware failure has occurred during the transfer of the data 
from the LogTag to the computer. In this scenario the problem is typically resolved by 
trying to retrieve the recordings from the LogTag again, while ensuring the contacts 
on the back of the LogTag are clean, that the contacts within the Interface Cradle are 
clean and that the contacts within the Interface Cradle are returning evenly to their 
normal position when the LogTag is removed.  
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Since the software does not modify any of the recorded data within a LogTag file at any 
time, if the software can open the file, regardless of how long ago it was created, the 
contents of the file will still represent the original recorded information retrieved from the 
LogTag. 

Therefore, the files created by the LogTag Analyzer software meet all criteria for data 
integrity and data security as set forth in the US FDA 21 CFR Part 11 regulations. The 
firmware code that is embedded in the processor chip of each LogTag cannot be 
extracted or reverse-assembled. Accordingly, data sets that are recorded on the memory 
within the LogTag cannot be downloaded or modified except by being transferred to a 
LogTag file. There is no way to interfere with the process of the transfer of information 
between the LogTag and the software in such a way that data integrity would be 
compromised. 

 
 

Viewing file properties 
The file properties, which is accessed through the File Menu and/or through the 
toolbar command, provides users with a brief summary about the data included within the 
file, as indicated in the following picture. 
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This file properties information is also available for viewing directly through the Windows 
Explorer software that was included with the Windows operating system, without the 
need to have the LogTag Analyzer software open. To view the information, simply locate 
the file of interest with Windows Explorer and, using the mouse, click the right button 
over the file and select the "Properties" menu item, with the left mouse button, from the 
menu that will be displayed, similar to the following picture. 

 

Select the "Summary" tab and you will see the summary of the data contained in the file. 
If the contents of the file require a newer version of software to open and view, have 
become corrupted or have been modified then the "Summary" tab will not be visible. 
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C H A P T E R  6  

Customizing the software 

In the "Edit" menu is a command called "Options...".  
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This menu command opens a Window, which will allow the many of the features that the 
software offers to be customized. The following sections will provide an explanation of 
each of these options so that users will be able to make the best use of the software. The 
options that are available for customization are grouped together into the following 
sections: 

 General Settings 

 Charts 

 Automation 

 File and Folder Settings 

 Exports and Reports 

 Date and Time 

 Communication Ports 

 User Server  

All of the options available will change the software in real time. For example, if the 
language selection and/or the date format are changed, all windows that are open will be 
updated without the need to restart the software. 

All these options, excluding the User Server settings, are stored on a per user basis. 
Therefore, if more than one user operates on a single workstation the software will allow 
different customization settings for each. 

In This Chapter 

General Settings.....................................................77
Summary Statistics.................................................78
Chart Statistics.......................................................78
Charts ...................................................................79
Automation............................................................80
File and Folder Settings ..........................................81
Exports and Reports ...............................................85
Dates and Times ....................................................87
Communication Ports..............................................89
User Server............................................................90
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General Settings 
The General Settings options allow you to change various preferences that will effect the 
overall appearance of the information shown by the software. 

 
 

Show temperatures in 

This will determine what units of measurement temperatures will be displayed in. The 
options include: 

 Fahrenheit (°F) 

 Celsius (°C) 

 Kelvin (K) 
 

Use Font 

Determines what font to use to display and print information about LogTag recordings 

and is changed through the  button. A sample of the font selected will be shown 
to you on the screen. 
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Language 

This instructs the software which language for the software to use for all the information 
it displays and prints. 

 
 

Summary Statistics 
This option allows you to specify which statistics are displayed in the Summary tab. The 
statistics can be enabled or disabled by clicking the tick box for the relevant item in the 
list. 
 

Chart Statistics 
This option allows you to specify which statistics are displayed on the charts. The 
statistics can be enabled or disabled by clicking the tick box for the relevant item in the 
list. 
 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



 Chapter 6    Customizing the software 79 
 
 

Charts 
The Charts options allow the various aspects of the charts that display the readings 
recorded by LogTags to be customized. At the base of the Window is a color selector and 
other relevant controls, which apply to the highlighted item on the list in the window.  

 

Some experimentation with these settings will show very quickly how they work. Select a 

color in the color panel, click , and then go to the Data screen to see the 
results of the change. 

Note that the three regions on the chart display can be controlled. LogTags can be 
configured to detect over and under conditions based on a series of temperature and/or 
humidity measurements. When the data is displayed graphically on the chart, these 
become color background regions. These are different colors for "above high alert limit", 
"between high alert limit and low alert limit" and "below low alert limit". This allows out-
of-range and in-range data to be spotted easily on the listed or charted data. 

By selecting a line style for the "above high alert limit" and "below low alert limit" regions 
you can improve the readability of the charts on black and white printouts. 

Most of these settings can also be enabled or disabled by clicking the tick box for the 
relevant item in the list. 
 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



80 LogTag Analyzer  
 

Automation 
The Automation options determine what the software does automatically when it detects 
a LogTag in the Interface Cradle. 

 
 

Enable automatic download of readings from LogTags 

Instructs the software to automatically retrieve recordings from a LogTag when it is 
placed in an Interface Cradle that is connected to the computer. While the software is 
automatically retrieving recordings from a LogTag an animated picture will appear on the 
screen to let the user know this action is being performed. With this function enabled, it is 
not necessary to go through the download wizard procedure. This function is very useful 
when working with multiple LogTags. 

This function can be temporarily disabled by holding down the "Ctrl" key on the keyboard 
while a LogTag is placed in the Interface Cradle. 
 

Display readings after successful download 

Instructs the software to display the recordings after downloading them from the LogTag. 
The default display format is determined by the "Display" setting in the "File Settings" 
option. This option will affect readings downloaded through the automatic download 
feature and when downloading through the Wizard approach. 
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Only show the latest set of readings after download 

Instructs the software to only display the most recently retrieved set of readings on the 
screen. If there are multiple windows of readings open and being displayed, all of these 
windows will therefore be automatically closed and only the most recently retrieved set of 
readings will be displayed. 
 

File and Folder Settings 
The File and Folder Settings options help you manage the LogTag data files.  

 
 

Display X items in my most recently used list 

This determines how many of the most recently accessed files are listed in the "File" 
menu for quick access to be opened and viewed again. Once this number of files has 
been reached, the reference to the oldest file opened will be removed and the most 
recently opened file will be added to position 1. Only the file reference is removed from 
this list, the actual file is not deleted. 
 

Display 

This determines how the information retrieved from a file and/or LogTag will be first 
displayed. All other ways of displaying information will still be available regardless of 
which is selected here. The options include: 

1 Chart, which will display the data in a time versus humidity and/or temperature chart. 
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2 Data, which will display a listing (spreadsheet style) of the time versus humidity 
and/or temperature data. 

3 Summary, which will display a summary of the data, including averages, ranges, alert 
results, LogTag identification data, and other information. 

 

File Name 

Whenever information is retrieved from a LogTag it is always automatically saved to disk. 
This entry determines the method to be used to create a meaningful name of the file that 
will contain the data downloaded from the LogTag.  

The button at the end of the edit control ( ) can be used to assist you with defining 
how file names are to be created by inserting the appropriate predefined element that 
matches the information you want to use. Clicking on this button will display a popup list, 
similar to the following picture to allow you select from the available elements. 

 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



 Chapter 6    Customizing the software 83 
 
 

To customize how the file name is created, you may use one or more of the available 
elements in any order. If you use spaces to separate the elements, these spaces will 
appear in the same location in the name of the file created. The letters must be in 
uppercase or lowercase as shown in the following table (for example, "%ID" not "%id") 
and all elements must be preceded by % if specified. Other characters that are included 
will appear in the same location and unchanged in the file name creation. 

Element Meaning 

%DATE The date when the LogTag information was originally retrieved. 

%DATE-TIME The date and time when the LogTag information was originally 
retrieved. 

%FINISH The date and time of the last reading recorded after being started. If 
the LogTag was not started then this information will be blank. 

%FINISH-DATE The date of the last reading recorded after being started. If the LogTag 
was not started then this information will be blank. 

%FINISH-TIME The time of the last reading recorded after being started. If the LogTag 
was not started then this information will be blank. 

%FIRST The date and time of when the LogTag began recording information, 
even if it was under pre-start conditions.  

%FIRST-DATE The date of when the LogTag began recording information, even if it 
was under pre-start conditions.  

%FIRST-TIME The time of when the LogTag began recording information, even if it 
was under pre-start conditions.  

%ID The unique LogTag identification value. 

%LAST The date and time of the last reading recorded, even if there are only 
pre-start recordings. 

%LAST-DATE The date of the last reading recorded, even if there are only pre-start 
recordings. 

%LAST-TIME The time of the last reading recorded, even if there are only pre-start 
recordings. 

%PRODUCTID The product identifier (part number) for the LogTag used to record the 
data. 

%SERIALNUM The unique serial number of the LogTag. 

%START The date and time the LogTag was started to record information. If the 
LogTag was not actually started and only pre-start information was 
recorded then this information will be blank. 

%START-COUNT The number of times the LogTag has been started since manufacture. 

%START-DATE The date the LogTag was started to record information. If the LogTag 
was not actually started and only pre-start information was recorded 
then this information will be blank. 

 %START-TIME The time the LogTag was started to record information. If the LogTag 
was not actually started and only pre-start information was recorded 
then this information will be blank. 
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%TIME The time when the LogTag information was originally retrieved.  

%USERID The user defined identifier for the set of information recorded by the 
LogTag. 

You may use the \ character to specify that a file name definition includes a sub folder 
name as well as the actual file name, which is useful if you want to group/sort files 
automatically together, for example, by date or by User Id. 

Each of the following elements within the quotes (") are not permitted, as they are not 
supported the operating system ": * ? < > |". If you do include one of these elements in 
the definition of how the file names are to be created they will be replaced with the _ 
character. 

If you use a date and/or a time element, the format of that element will be determined by 
the settings defined in the "Date and Time" set of options. 
 

Folder 

This determines the location where the files are automatically stored. The location defined 
here can specify a local drive path or a network drive path. UNC folder names are 

supported. The ( ) button at the end of the edit control will assist you to locate the 
default store folder by browsing the folder structure available to you, if you choose to use 
it. 

Since this is the default location where files are stored, this also represents the default 
folder that will be used when searching for files to open (through the Open command in 
the File menu). 
 

Uniqueness 

This determines how the software will manage information retrieved from a LogTag when 
a file of the same name already exists. For example, when you retrieve the information 
from the same LogTag once every day, while the LogTag is still recording and the LogTag 
has not been prepared for its next use and started again. The options available include: 

1 Always create a unique copy of files (recommended) 

If a file of the same name already exists, then the software will automatically append " 
Copy n" to the end of the file name, where "n" will be a unique number. 

2 Overwrite file if the file already exists 

If a file of the same name already exists, the existing file is overwritten (deleted and 
replaced) with a file that contains the information just retrieved from a LogTag. 

3 Prompt if an existing file already exists. 

If a file of the same name already exists, then you will see a message appear asking 
you whether or not you want to overwrite and replace the existing file with the 
information just retrieved from the LogTag.  

If you answer "Yes" then the action described in the option "Overwrite file if the file 
already exists", previously explained, will be performed. 
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If you answer "No" then the action described in the option "Always create a unique 
copy of files (recommended)", previously explained, will be performed. 

 

Exports and Reports 
Every time recorded data is retrieved from a LogTag it is automatically saved to disk in 
the software's native format so that it can be opened and viewed at a later date. 
However, it may be that the recorded data is to be regularly integrated with other data 
and/or view the recorded data using software other than LogTag Analyzer. Exports and 
Reports will instruct the software to automatically create one or more files in a format 
that is compatible with the other software being used, whenever recorded data is 
retrieved from a LogTag. 
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To instruct the software to create a copy of the file in a format other than the native 
format used by LogTag Analyzer, simply tick the file format from the list available. To 
override and customize the contents of the particular file format, simply ensure the file 

format is highlighted and click . Once  has been clicked, a window 
will be displayed that will show the available options that can be overridden. 

 

All the additional files created will be automatically saved at the appropriate time using 
the filename and folder location defined in the "File and folder settings" options. Since 
these file formats are not the native LogTag Analyzer file format, the LogTag Analyzer 
software will no longer be able to detect whether or not the data within it is genuine and 
original and will not be able to display the information within the file. 
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Dates and Times 
The Date and Time options allow how the date and time information is displayed by the 
software to be overridden. It does not affect how the date and time information is stored 
and therefore, how the date and/or time information is shown can be changed at any 
time. At the bottom of this option window, a sample of the date and time using the 
formats selected will be displayed. 

 

To customize how the date information is displayed, the following elements may be used. 
If spaces are used to separate the elements, these spaces will appear in the same 
location in the date displayed. The letters must be in uppercase or lowercase as shown in 
the following table (for example, "MM" not "mm"). Characters that are enclosed in single 
quotation marks will appear in the same location and unchanged in the date displayed.  

Element Meaning 

d Day of month as digits with no leading zero for single-digit days. 

dd Day of month as digits with leading zero for single-digit days. 

ddd Day of week as a three-letter abbreviation. 

dddd Day of week as its full name. 

M Month as digits with no leading zero for single-digit months. 

MM Month as digits with leading zero for single-digit months. 

MMM Month as a three-letter abbreviation. 

MMMM Month as its full name. 
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y Year as last two digits, but with no leading zero for years less than 10. 

yy Year as last two digits, but with leading zero for years less than 10. 

yyyy Year represented by full four digits. 

 

To customize how the time information is displayed, the following elements may be used. 
If spaces are used to separate the elements, these spaces will appear in the same 
location in the time displayed. The letters must be in uppercase or lowercase as shown in 
the following table (for example, "ss", not "SS"). Characters that are enclosed in single 
quotation marks will appear in the same location and unchanged in the time displayed.  

Element Meaning 

h Hours with no leading zero for single-digit hours; 12-hour clock. 

hh Hours with leading zero for single-digit hours; 12-hour clock. 

H Hours with no leading zero for single-digit hours; 24-hour clock. 

HH Hours with leading zero for single-digit hours; 24-hour clock. 

m Minutes with no leading zero for single-digit minutes. 

mm Minutes with leading zero for single-digit minutes. 

s Seconds with no leading zero for single-digit seconds. 

ss Seconds with leading zero for single-digit seconds. 

t One character time-marker string, such as A or P. 

tt Multi character time-marker string, such as AM or PM. 

 

For example, if the date was 2 January 2004 and the date format was defined as "yy-M',' 
dd" (excluding the double quotes) the date would be displayed as "04-1, 02". 
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Communication Ports 
The Communication Ports options control which communication ports are checked for 
connected Interface Cradles. This allows certain communication ports to be excluded, 
which are not used to connect Interface Cradles to and/or are regularly used for other 
applications, thereby reducing the possibility that this software will interfere with the 
operation of other applications running on the current system.  

The software checks each communication port at the same time, rather than one after the 
other, therefore having the software check multiple communication ports will not 
adversely affect the performance of the software significantly. As the software supports 
multiple communication ports, it is possible to connect and use to more than one 
Interface Cradle at the same time. 
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User Server 
The User Server options define if and where the software should connect to the LogTag 
User Server software. If you do not have LogTag User Server software installed on your 
computer and/or available on your local area network, you will not need to make any 
changes to this set of options. Connection to the LogTag User Server software is typically 
only used within a multiple computer user environment and/or if your organization 
requires compliance with the US FDA 21 CFR Part 11 regulations, for use of digital 
signatures that are controlled by a central administrator. 

 

You will need to consult your network administrator and/or documentation pertaining to 
the LogTag User Server software to determine what settings should be used in this set of 
options. You will not be able to change these settings if the software is unable to establish 
a valid connection with the LogTag User Server software.  

Once a valid connection to the LogTag User Server software has been established, you 
will be required to "log on" to the software to continue using it. 
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Menus and Toolbars 

At the top of the screen for the LogTag Analyzer, just below the title bar, which contains 
the name of the software, is the menu system and toolbar for the software. The toolbar 
provides quick access to some of the more commonly used functions within the menu 
system. The menu system contains lists of all the operations and commands that are 
available to you while using the software. 

 

 

In This Chapter 

Menu commands....................................................92
Toolbar commands.................................................100
Print preview toolbar ..............................................101
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Menu commands 
The menu system has been separated into groups of related commands. Each of these 
menu groups is explained in more depth in the subsequent sections. The software will 
only display the menu groups and commands within each menu group that are 
appropriate depending on what you are currently doing with the software. 

You may also see that some of the menu commands have a reference after the command 
name, for example F2 or Ctrl+O. These represent key strokes on the keyboard that 
instruct the software to perform the appropriate command, without out the need to select 
the menu or toolbar command. When only one key reference is mentioned, for example 
"F2", then pressing that single key on the keyboard will cause the appropriate command 
to be performed. If there is more than one key reference mentioned, for example Ctrl+O, 
then to cause the command to be performed you must press and hold down the first key 
mentioned while pressing the other key once. When letters are used in the key reference, 
for example Ctrl+O, it does not matter whether or not the caps lock is on or off. 

In This Section 

File Menu...............................................................93
Edit Menu ..............................................................95
LogTag Menu.........................................................97
Window Menu........................................................98
Help Menu .............................................................99
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File Menu 
The "File" menu contains commands that generally relate to a LogTag file as a whole. A 
LogTag file contains a variety of information that relates to a data set representing 
readings that were recorded over a discrete period of time by a single LogTag. The File 
menu will appear similar to the following picture. 

 

The following table outlines the commands and the explanation of each command that 
may appear in the "File" menu when using the LogTag Analyzer software: 

Command Explanation 

Open... ( ) This will display the Open file dialog, which will allow you to 
open a LogTag file that contains readings previously retrieved. 
It will start at the folder defined in the File and Folder 
Settings section in the Options. 

Close This command will close all windows that are displaying 
information about the open file that is currently selected. If no 
files are currently open this command will not be visible. 
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Multi Chart ( ) This will change the way recordings are displayed such that 
they are all combined on a single chart window. 

Single Chart ( ) This will change the way recordings are displayed such that 
each which will contain all the information retrieved from a 
single LogTag. 

Save ( ) This will save any changes you have made to the LogTag file 
to your disk drive. 

Save As... This will display the Save As file dialog, which will allow you to 
save a copy of the file currently being displayed in the same or 
different folder with the same or different file name.  

Print... ( ) This will open a window allowing you to print a copy of the 
LogTag file to an output device, which will typically be a 
printer. This command is further explained in the section 
"Printing the results". 

Print Preview This will change the display mode of the software to show you 
a copy of how a printout of the currently selected file and 
window would look like. In "Print Preview" mode you will not 

be able to zoom in or out of a chart. Click  to exit 
the "Print Preview" mode and return to normal display mode. 

Print Setup... This will open a window allowing you to view and/or adjust 
one or more of your printer's settings. 

Send... ( ) This will help you send, by email, the currently open and 
selected LogTag file to another user without the need to exit 
to your email software or to deal with file attachments. This 
command is explained in further detail in the section 
"Sending a file by email direct from Analyzer". 

Properties... ( ) This will open a window that will display the information about 
the file that is being displayed and currently selected. This 
same window and information will be displayed if you view the 
properties of the file from Microsoft Windows Explorer. 

Digital Signature... ( ) This will open a window to display a list of digital signatures 
that have been included with the file. It also allows you to add 
and print this list of digital signatures. This command is 
explained in further detail in the section "Digital signatures". 

User logon... ( ) This allows a user to logon to and use the Analyzer software. 
When the software is connected to the User Server software, 
users must logon to the software prior to being permitted to 
use the software. Therefore, this command will only be 
available if the Analyzer software is connected to the User 
Server software. If a user is already logged on to the software, 
then this command is not visible. The section "User Server" 
explains in more detail how to get the Analyzer software to 
connect to the User Server software. 

Logoff user (username) (
) 

This allows the currently logged on user to logoff the Analyzer 
software. The username portion of this command will 
represent the name of the user currently logged on. If there is 
no currently logged on user, this command is not visible. 
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Change Password... This allows the currently logged on user to modify their 
password that they use to logon to the Analyzer software. This 
command will only be available if the Analyzer software is 
connected to the User Server software and the User Server 
administrator has granted the appropriate user permissions. 

1, 2, 3, etc This portion of the menu represents a list of the most recently 
files you have viewed. To reopen one of these files, simply 
click on the entry (name of the file) to open. If a file that you 
want to view is not included in this list, you may use the 
"Open..." command included in this menu. The number of files 
included in this list can be adjusted through the "General 
Settings" section of the Options. 

Exit This command will exit and close down the LogTag Analyzer 
software. Any files that you currently have open will also be 
closed automatically for you. If a user is currently logged on to 
the Analyzer software when the Analyzer closes, the user will 
be automatically logged off. 

  
 

Edit Menu 
The "Edit" menu contains commands that generally relate to the contents of a LogTag file 
and will appear similar to the following picture. 

 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



96 LogTag Analyzer  
 

The following table outlines the commands and the explanation of each command that 
may appear in the "Edit" menu when using the LogTag Analyzer software: 

Command Explanation 

Copy ( ) Places a copy of the contents of the currently displayed 
window onto the clipboard, which can then be pasted into 
any Windows® application. If you are copying a chart, the 
chart at its current zoom range is copied to the clipboard. If 
you are copying from one of the tabular style windows (Data 
or Summary), then the entire contents of the window is 
copied to the clipboard, regardless of what part of the data 
you have scrolled to view. 

Zoom Out ( ) This will undo the last zoom operation performed allowing 
you to see more of the data on the chart. If the chart is 
displaying all the readings recorded by the LogTag, this 
command will not be available.  

Zoom to Marks ( ) When this command is enabled, the chart is automatically 
zoomed to show readings recorded between inspection 
marks. The section "Starting and using the LogTag" 
explains in further detail how inspection marks are recorded. 

Previous group of Marks ( ) This command will show the readings recorded between the 
first inspection mark shown and the previous inspection mark 
recorded. This command will only be available if the "Zoom 
to Marks" command is enabled and the first reading recorded 
is not currently visible. 

Next group of Marks ( ) This command will show the readings recorded between the 
last inspection mark shown and the next inspection mark 
recorded. This command will only be available if the "Zoom 
to Marks" command is enabled and the last reading recorded 
is not currently visible. 

Options... ( ) This will open a window allowing you to customize the 
software. This command is further explained in the chapter 
"Customizing the software". 
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LogTag Menu 
The "LogTag" menu contains commands that generally relate to the usage and interaction 
with LogTags.  

 

The following table outlines the commands and the explanation of each command that 
may appear in the "LogTag" menu when using the LogTag Analyzer software: 

Command Explanation 

Configure... This will display a wizard to help you through the necessary 
steps to prepare LogTags for their next use. This command is 
explained in further detail in the chapter "Preparing LogTags 
for use". 

Download... This will display a wizard to help you through the necessary 
steps to retrieve a copy of the recorded readings stored within 
the LogTag(s). This command is explained in further detail in 
the chapter "Results from LogTag". 

Hibernate... This will display a wizard to help you through the necessary 
steps to set LogTags to "Hibernation" mode. This command is 
explained further in the chapter "Prolonging battery life" 

Wizard... ( ) This will display a wizard to help you through the necessary 
steps to retrieve a copy of the recorded readings stored within 
the LogTag(s) and then prepare the LogTags for their next use. 
This command is explained in further detail in the chapter 
"Quick Start Guide". 

 
 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



98 LogTag Analyzer  
 

Window Menu 
The "Window" menu contains commands that relate to the management of each Window 
open within the LogTag Analyzer software that displays the contents of a LogTag file.  

 

The following table outlines the commands and the explanation of each command that 
may appear in the "Window" menu when using the LogTag Analyzer software: 

Command Explanation 

New Window Opens a new window that contains a copy of the information of 
the currently selected window. This command is useful when 
you need to closely inspect and analyze different sections of the 
same data set. 

Close Closes the currently selected window within the LogTag 
Analyzer software. 

Close All Closes all the windows within the LogTag Analyzer software. 

Cascade Arrange all the windows within the LogTag Analyzer software in 
an overlapping style. 

Title Horizontally Arrange all the windows within the LogTag Analyzer software as 
horizontal non-overlapping tiles. 

Title Vertically Arrange all the windows within the LogTag Analyzer software as 
vertical non-overlapping tiles. 

Arrange Icons Arrange all the minimized windows within the LogTag Analyzer 
software at the bottom of the main window. 

1, 2, 3, etc The tick mark beside these entries indicates the window that is 
currently selected. If you want to change the currently selected 
window to one of the windows listed, just click/select the 
appropriate entry on this list. 
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Help Menu 
The "Help" menu contains commands that relate to providing you with help and 
assistance with using the LogTag Analyzer software.  

 

The following table outlines the commands and the explanation of each command that 
may appear in the "Help" menu when using the LogTag Analyzer software: 

Command Explanation 

Help Topics ( ) Opens a window that contains the online help. 

User Guide ( ) Opens the online user guide for viewing. Requires Adobe 
Acrobat and/or Adobe Acrobat Reader software, version 4 
or later, to be installed on the computer. 

LogTag Home Page... ( ) This will open your default Internet browser software and 
display the LogTag Recorders Internet site, 
www.logtagrecorders.com. This command requires that 
your computer be currently connected to the Internet to 
successfully display the LogTag Recorders Internet site. 

Request help... ( ) This will gather non personal information from your system 
to include in the email to be sent to software support at 
LogTag Recorders, so that the support team will be 
informed of the relevant information about your system in 
order to provide you with quality and useful assistance. 
This command is explained in further detail in the chapter 
"Getting more help". 

Check Internet for update... This is a simple way of checking to see if there is a newer 
version of this software available for download. This 
command is explained in further detail in the chapter 
"Getting updated software". 

About LogTag Analyzer... 
( ) 

Display the version information about the LogTag Analyzer 
software that you are using. 
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Toolbar commands 
Each picture on the toolbar represents a unique command. The pictures that are included 
on the toolbar represent the following commands: 

 This will bring up the LogTag Wizard, which will take you through the steps to retrieve 
readings from connected LogTag(s) and prepare them for their next use.  

 This will display the file open window to allow you to locate and open LogTag files that 
contain previously retrieved LogTag readings. 

 Save a copy of the LogTag data to a file on your disk drive. 

 Open the window that will allow you to print a copy of the LogTag data to a printer. 

 Displays file properties about the currently selected open file. 

 Displays information about any digital signatures included in the currently selected 
open file, which is also allows where new digital signatures can be added to the file 
and where you can print a copy of the digital signatures. 

 Creates a new blank email for sending a copy of the currently selected open file as an 
attachment to a recipient of your choice.  

 Places a copy of the currently displayed information to the Windows clipboard so that 
you can paste it into another Windows software package. 

 Zooms out one level of the actively displayed chart. If you are displaying a chart and 
this function is not available, then all data that is available to be displayed is currently 
been displayed and therefore there is no more additional information that can be 
displayed by zooming out. 

 This zooms the chart to show information between the oldest reading recorded and 
the first inspection mark that exists amongst the data. If this function is not available 
then there is no inspection marks in the data currently been displayed. The next two 
commands will not be available until this command is activated. 

 This zooms the chart to show the group of data that was recorded between the 
previous inspection mark and the first inspection mark currently been displayed. This 
function is disabled when either the oldest reading is already been displayed or the 
chart has not been zoomed into showing groups of readings between inspection 
marks.  

 This zooms the chart to show the group of data that was recorded between the next 
inspection mark and the last inspection mark currently been displayed. This function is 
disabled when either the newest reading is already been displayed or the chart has not 
been zoomed into showing groups of readings between inspection marks.  

 Switches into Multi Chart mode, which displays all currently open charts together in 
one window. Any additional charts that are opened will be added to the Multi Chart 
window. 

 Switches into Single Chart mode. Each chart that is currently open will be displayed in 
its own window. 

 This will open a window allowing you to customize the software. This command is 
further explained in the chapter "Customizing the software". 
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 This will log a user on to the software if no user is currently logged on or log off the 
currently logged on user. This command will only be available if the software is 
connected to the LogTag User Server software. 

 This will allow you to show the help topic on any particular command or topic that you 
subsequently select. 

 
 

Print preview toolbar 
The print preview feature, available through the File menu, of the software will display 
copy of the data as it would be included on a print out. When the software is displaying a 
file in print preview mode, an additional toolbar will appear, similar to the following 
picture. 

 

Command Explanation 

Print... This will open a window allowing you to print a copy of the 
LogTag file to an output device, which will typically be a 
printer. This command is further explained in the section 
"Printing the results". 

Next Page This will display the next page included in the print out. This 
button will be disabled if there are no more pages available to 
be displayed. 

Prev Page This will display the previous page included in the print out. 
This button will be disabled if there are no previous pages 
available to be displayed. 

One Page Selecting this button will change the display so that only one 
page is displayed at a time. Once this button is selected it will 
change to "Two Page". 

Two Page Selecting this button will change the display so that two 
consecutive pages are displayed side by side at the same time. 
This button will be disabled if there is only one page in the 
print out, like a chart. Once this button is selected it will 
change to "One Page".  

Zoom In This will zoom in the display of the print out making it appear 
larger on the screen. It will not effect what information is 
included in the print out. 
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Zoom Out This will zoom out the display of the print out making it appear 
smaller on the screen. It will not effect what information is 
included in the print out. 

Close This will close the print preview mode of display and revert the 
display of the data back to normal mode, which will allow 
users to switch between chart display and data listing display, 
for example. 
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Working with Networks 

When using and deploying software in a network environment, network administrators 
often require additional technical information about the software so they can integrate 
support for it correctly and seamlessly. This chapter briefly covers some points of interest 
for computer network administrators. 

In This Chapter 

Distributing software to workstations.......................103
Restricting what users can do .................................104
How users log on ...................................................105
How users change their password ...........................106
 
 

Distributing software to 
workstations 
When using the software on many computers within a computer network, it is not always 
efficient to visit and install the software and subsequent updates manually on each 
computer workstation. The installation of the software does support zero administration 
installation, whereby the installation package can be located on a central point, usually a 
server, and have it install on each relevant workstation, without requiring user 
intervention. 

To distribute the software without user intervention is a two step process. 

1 Create an installation script file that will provide the answers and actions to be 
performed on each step of the installation process. To create an installation script, use 
the following command line syntax, including the quotes as used: 

\\myserver\my_apps_path\setup.exe /a /r /f1"\\myserver\my_apps_path\setup.iss" 

2 Ensure that whenever a user installs the software the installation script is used. To 
install the software using an installation script previously created use the following 
command line: 

\\myserver\my_apps_path\setup.exe /s /a /s /f1"\\myserver\my_apps_path\setup.iss" 

Where,  

a "\\myserver\my_apps_path\" represents the network path to the folder containing the 
installation of the LogTag Analyzer software.  

b "setup.exe" is the installation software.  
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As many different installation scripts as are suitable for your situation may be defined and 
used. 

LogTag Analyzer software is released on the LogTag Recorders Internet site using a 
standard filename syntax, which is  
[software_name][major_version][minor_version]r[release_version].exe. For example, if 
the file name of the installation package was "logtag_analyzer10r24.exe" the name of the 
software would be "LogTag Analyzer" version 1.0 Release 24.  

The installation of the LogTag Analyzer software involves copying a number of files to the 
destination folder, which can be chosen during the installation process, a file is installed in 
the Windows System folder and some plug and play drivers to support the USB Interface 
Cradle. Therefore, when deploying the software onto Windows NT® based operating 
systems, like Windows NT®, Windows 2000® and Windows XP®, the user installing the 
software will require local administrator privileges for the software to install correctly. It is 
possible, to elevate a users permissions on a Windows NT® based server network for the 
sole purpose of being able to install the software successfully through the use of a Group 
Policy Object.  

When installing the software on to a Windows NT® operating system, the plug and play 
drivers for the USB Interface Cradle will not be installed as Windows NT® does not support 
USB devices. 
 

Restricting what users can 
do 
In a multiple user environment, it is not always desirable to allow every user to perform 
any and all tasks with the software. For example, to ensure all documents printed from 
the software use the same date/time display format, it may be desirable to not allow 
users to customize the software to change how the software displays dates and times. To 
provide administrators of systems with a central point of control, LogTag Recorders has 
developed a software package called "LogTag User Server", which when used in 
conjunction with this software, it will provide an administrator with the ability to choose 
whether or not to restrict what users can and cannot do with this software. 

To find out more about LogTag User Server, please contact your network administrator 
and/or your LogTag reseller. 
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How users log on 
When the software has been customized to be connected to the LogTag User Server 
software, all users are required to successfully logon to the software before being 
permitted to use any of the features and functionality of the software. For a user to 
successfully logon to the software, the user must enter their username, which the 
administrator would have assigned, and their password. Username's are typically not case 
sensitive, however passwords are. That is, entering the Username "Bob Smith" is the 
same as entering "BOB SMITH" and "bob smith". However, entering a password of "bob" 
rather than "Bob", for example, is considered to be different. 

 

Every logon attempt, whether successful or not, may be recorded automatically in the 
audit logs by the administrator. As a security measure, the network administrator may 
configure the LogTag User Server software so that a user account becomes locked and 
therefore temporarily inaccessible if a certain number of consecutive failed logon attempts 
are made to the user account. Please contact your network administrator if you have 
problems with the logging on the software. 
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How users change their 
password 
When the software has been customized to be connected to the LogTag User Server 
software, the network administrator may require and/or permit users to change the 
password used to logon to the software. Users are only permitted to change the password 
for the user account that is currently logged on, which is typically their own, and as a 
security precaution, users will always need to supply their current logon password before 
being permitted to change it.  

The network administrator may enforce certain rules pertaining to what is a valid 
password. For example, they may require a minimum number of characters (digits, letters 
or symbols) and/or a minimum number of digits to be included in the password. Please 
contact your network administrator if you have problems with the logging on the 
software. 

 

Passwords should be chosen such that they would be difficult for some one else to guess. 
If another person was able to guess the password they would be able to logon and 
impersonate the user. Therefore, following are a few points to remember when changing 
a password: 

1 Do not use something that is personal to the user. Birth dates, license plate numbers, 
names of family members, types of vehicles owned, favorite foods and address of 
residence are all examples of passwords that should NOT be used. 

2 Do not write it down. 

3 Change the password on a regular basis. 

If a user's password is forgotten, the network administrator will be able to change it. 
However, network administrators will not be able to see and therefore inform users what 
their current password is. 
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Getting more information 

In This Chapter 

Getting updated software .......................................107
Finding your software version .................................109
Getting more help ..................................................110
 
 

Getting updated software 
There are two ways to see if a newer version of the LogTag Analyzer software is available 
and download a copy if a newer version exists. 

1 Within the "Help" menu item in the software is a command called "Check Internet for 
update..." 

 

2 Visit the LogTag Recorders Internet Site, www.logtagrecorders.com, and follow the 
relevant instructions to obtain a copy of the software. 
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The first option will download from the LogTag Recorders Internet site the relevant 
information about the latest version of the software available and compare this 
information with the software that has already been installed. The software will then let 
you know whether or not a newer version of the software is available. During this entire 
process no information about you or your system is transmitted out from the LogTag 
Analyzer software and therefore you can rest assured that your privacy is maintained. 

While the software is retrieving the information from the Internet about the latest 
available version, the software will display its progress in a window similar to the following 
picture. 

 

If a newer version of LogTag Analyzer is available a "Download" button will appear. 
Clicking "Download" will begin the download process, in which you select the location for 
the installation file. After the installation file has been downloaded you will need to close 
LogTag Analyzer and then start (open) the downloaded file to begin the installation. 

Installing a newer version of the LogTag Analyzer software will update all the relevant 
program files. It will not affect any of your LogTag data files or your custom settings of 
the software. Software updates usually include feature enhancements and/or resolve 
problems discovered with the software subsequent to its release. We recommend you use 
the latest version of the LogTag Analyzer software available. 
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Finding your software 
version 
Within the "Help" menu, is the "About LogTag Analyzer..." command, which will display a 
Window similar to the following picture. 

 

Within this window, amongst other information, the full version number of the software 
being used is displayed. This information is useful, for example, to determine if the same 
software version is installed on multiple computers and/or if the user guide being 
referenced refers to the version of software being used.  

For example, if the window shows the software to be "LogTag Analyzer 1.4" and the 
version of this guide is 1.4, then the contents of this user guide refer to the version of 
software being used. If however, this window shows the software to be "LogTag Analyzer 
1.0" and the version of this guide is 1.4, then this version of the user guide does not refer 
to the version of the software being used. The version of this guide is 1.4, which is also 
shown on the cover page of the guide.  

Each time the software is updated one part of the version number of the software is 
always increased. The "Build" number portion is increased for a given version of the 
LogTag Analyzer software when the change included in the software will not affect the 
matching version of the user guide. For example, version 1.4 of the guide refers to both 
the "LogTag Analyzer, Version 1.4 Build 2" and the "LogTag Analyzer, Version 1.4 Build 5" 
of the software.  
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Getting more help 
The time may arise when this guide is unable to provide you with the assistance you 
require. The LogTag Analyzer software includes a way to make the process of getting 
further assistance from LogTag Recorders as simple as possible, while providing the 
support team at LogTag Recorders with enough information about your system to be able 
to provide you with useful assistance. Within the "Help" menu of the software is a 
"Request help..." command.  

 

This command will gather non personal information from your system to include in the 
email, which you can review if you want to, so that LogTag Recorders will be informed of 
the relevant information about your system in order to provide you with quality and useful 
assistance. Please include in the email as much information and detail about the problem 
that you are experiencing with the LogTag Analyzer software as possible, even if you may 
think it to be irrelevant, as the more information that is available the more likely LogTag 
Recorders will be able to provide you with an appropriate solution quickly. 

If you have suggestions for software improvements, you may also use this method to 
send your ideas through as LogTag Recorders is always in the process of improving the 
software and adding additional features to it, so that the software becomes increasingly 
more efficient, effective and useful for users. 
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Appendix 

In This Chapter 

Troubleshooting .....................................................111
Resolving USB Driver Problems ...............................113
Sensor Responsiveness...........................................136
 
 

Troubleshooting 

Problem Solution 

My LogTag appears to be “dead”. No 
lights are flashing. 

This could represent either of two conditions: 

1 The LogTag is ready to start, but has not 
been started yet. 

2 The LogTag is simply in a state where the 
configuration has the LED flashing turned 
off. This is an option that may be selected 
when a LogTag has been shipped to the 
user for the first time (to preserve battery 
life) or it may be that the last configuration 
setting selected no LED display. 

3 The LogTag is in "Hibernation" mode. Refer 
to "Prolonging battery life" for further 
information. 

4 The battery is dead and the LogTag is 
expired. 

How to test:  

1 Try pressing the START MARK button on the 
LogTag. 

2 Start the LogTag Analyzer software and 
place the LogTag into the Interface Cradle. 
Download the LogTag. If the LogTag can be 
identified by the software, then the battery 
is good, and the LogTag is OK. 
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I am unable to get a serial port “free”. 
Every time I run the software, every 
port shows that is already in use 

On rare occasions it may be difficult to configure 
some computers for releasing the assignment of a 
serial port from one application to another. Often, 
this will require the services of a computer technician 
or expert. One simple solution is to purchase a USB 
Interface Cradle. USB connections do not have a 
“free port” limitation. 

What happens if there is an electrical 
current between the contacts…will 
that damage the LogTag? 

The contacts are isolated from the critical internal 
component such that incidental static discharge will 
not harm the LogTag. Deliberate application of a full 
outlet voltage (100 – 240 volts AC or 12-24 volts DC) 
to the LogTag may cause permanent damage. 

I cannot view the user guide that 
came with the software. 

The User Guide is in a 'PDF' file format and as such a 
special software package called "Acrobat Reader" is 
required to view it. Acrobat Reader is available for 
free download from the Adobe web site and can 
typically be downloaded from 
http://www.adobe.com/products/acrobat/re
adermain.html 
http://www.adobe.com/products/acrobat/readermain
.html. 

I cannot see all the readings in the 
"data" screen, some appear to be 
missing. 

The range of readings shown in the data screen 
represent the range of readings shown on the Chart 
screen. Whenever the Chart is zoomed in to show 
more detail the range of readings shown in the data 
screen is updated as well. If the chart is zoomed out 
( ) to show all readings that were recorded, then 
the data screen will also show all the readings that 
were recorded. 

Why are some of the readings shown 
"non validated". 

The LogTag automatically inserts error detection 
codes every 127 recordings which checks for the 
detection of corrupted or manipulated data. If the 
LogTag has been configured to do continuous 
recording then as each block of 127 logs is started 
to be replaced with the latest readings the data 
integrity error check for the "oldest" block will fail, 
which will therefore technically putting the block of 
data into doubt. This is not a problem rather that the 
particular block of data now has the lost a degree of 
data integrity protection and hence is labelled 'non-
validated'. 

Non-validated readings can also occur if there has 
been communications issues during data transfer 
from the LogTag or if the memory does actually have 
a fault, however these causes are very rare. 
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Resolving USB Driver 
Problems 
Every USB device requires the appropriate driver files to be installed prior to them being 
successfully used on a computer. The installation process of the LogTag Analyzer software 
will attempt to ensure the appropriate driver files are installed on the computer. These 
driver files may fail to install correctly if the USB Interface Cradle is connected to the 
computer prior to and/or during to the installation of the software. Therefore, it is 
strongly recommended that the software is installed prior to any USB Interface Cradles 
being connected to the computer. 

The following sections will guide you through the steps necessary to determine whether 
or not a problem exists with the installation of the USB drivers for the USB Interface 
Cradle are installed correctly on the computer and, if necessary, how you can resolve a 
problem with the installation of the USB drivers. 

In This Section 

Checking the installation of the USB driver...............113
USB driver installation through software installation .119
Manual USB driver installation on Windows XP .........121
Manual USB driver installation on Windows 2000......
Manual USB driver installation on Windows 98 or Me
 
 

125
131

Checking the installation of the USB driver 
The following will guide you through the steps necessary to determine whether or not the 
drivers for the USB Interface Cradle are installed correctly on the computer. 

1 Providing the LogTag Analyzer software has been already installed, connect the USB 
Interface Cradle to the computer by plugging the Interface into an available USB 
socket. USB sockets are typically located at the rear of the computer. 

 
2 Open the "Control Panel". This can be done by using the mouse to click on the 

Windows "Start" button, typically located in the bottom left of the screen, to open the 
Start menu. Once the "Start" button has been clicked, you will see a menu appear.  
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3 If your menu looks similar to the following picture, click on the visible "Control Panel" 
item. 

 

4 If your menu looks similar to the following picture, the "Control Panel" item is located 
within the "Settings" menu item. 
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5 Within the "Control Panel" window there is a "System" icon. For Windows XP users, 
you may need to "Switch to Classic View" to locate the "System" icon quickly. Start 
(open) the "System" icon once you have located it. 

6 If your system properties looks similar to the following picture, click the "Hardware" 
tab followed by the "Device Manager" button to open a view of the devices that have 
and have not been successfully installed on the computer. 
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7 If you system properties looks similar to the following picture, click the "Device 
Manager" tab to view the devices that have and have not been successfully installed 
on the computer. 
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8 Once the device manager is open you should see one of the three following images in 
the list, as indicated in the following picture. You may need to click on the "+" beside 
the "Universal Serial Bus controllers" entry to view all the USB devices that have been 
installed on the computer. 

 

If the USB device driver installed successfully but has not yet started, the following will 
guide you through steps necessary to start the USB drivers so that you can start using the 
USB Interface Cradle(s).  

If the computer is using Windows XP or Windows 2000: 

1 Open the "Device Manager" as described previously. 
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2 For each "USB Interface" entry displayed, using the mouse (pointing device), click the 
right button on the text of the "USB Interface" entry to display the popup context 
menu, which will be similar to the following picture. Once this pop context menu is 
visible, select the "Uninstall" option, using the left button on the mouse. 

 
3 Unplug all USB Interface Cradles that are plugged into the computer and/or are 

plugged into any USB hub that may be connected to the computer. 

4 Wait for at least 5 seconds. 

5 Plug the USB Interface Cradle(s) into the appropriate USB socket on the computer 
and/or USB hub that is connected to the computer. This should install and start the 
USB driver for the USB Interface Cradle(s). If the drivers do not successfully start, 
indicated by the "USB Interface" entry appearing in the device manager with either 
the  or the  picture, you may need to reinstall the USB driver files, which is 
described subsequently. 

If the computer is using Windows 98 or Windows Me: 

1 Open the "Device Manager" as described previously. 

2 Select each "USB Interface" entry displayed (one at a time) and then click the 
"Remove" button. 

3 Unplug all USB Interface Cradles that are plugged into the computer and/or are 
plugged into any USB hub that may be connected to the computer. 

4 Wait for at least 5 seconds. 

5 Plug the USB Interface Cradle(s) into the appropriate USB socket on the computer 
and/or USB hub that is connected to the computer. This should install and start the 
USB driver for the USB Interface Cradle(s). If the drivers do not successfully start, 
indicated by the "USB Interface" entry appearing in the device manager with either 
the  or the  picture, you may need to reinstall the USB driver files, which is 
described subsequently. 
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If the USB device driver files did not install correctly, you may either reinstall the software 
or manually install the USB driver files. The USB drivers where first released with the 
LogTag Analyzer software version 1.0 Release 74. If you have a version of the software 
prior to this, get a copy of the latest version of the LogTag Analyzer software and install 
the latest version of the software ensuring the all USB Interface Cradles are not 
connected to the computer during the installation process. 
 

USB driver installation through software 
installation 
To reinstall the software to install the USB drivers: 

1 Unplug all USB Interface Cradle(s) that are connected to the computer and/or 
connected to a USB hub that is connected to the computer. 

2 Start the Windows "Control Panel" 

3 Within the "Control Panel" window there is a "Add/Remove Programs" or "Add or 
Remove Software" icon. For Windows XP users, you may need to "Switch to Classic 
View" to locate the "Add or Remove Software" icon quickly. Start (open) the "Add or 
Remove Software" icon once you have located it. 

4 Locate the "LogTag Analyzer" entry and click the "Change/Remove" or 
"Add/Remove..." button. 

5 Once the "LogTag Analyzer Setup Maintenance" window is open, select the "Repair" 
option and then click the "Next >" button. 

6 Click the "Finish" button when it is displayed to complete the reinstallation of the 
software and USB driver files. 
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Note, if you see a window similar to the following picture appear during the installation of 
the USB driver files, you must click the "Continue Anyway" button for the USB driver files 
to successfully install. 
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Manual USB driver installation on Windows XP 
To manually reinstall the USB driver files, for Windows XP computers, open the "Device 
Manager". The "Device Manager" can be started by opening the "System" icon, located in 
the Windows "Control Panel", selecting the "Hardware" tab in the "System Properties" 
window and then click the "Device Manager" button. 
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1 Using the mouse (pointing device), click the right button to display the popup context 
menu, which will be similar to the following picture. 

 
2 Select the "Update Driver..." option, using the left button on the mouse, which will 

cause the device driver wizard to start, similar to the following picture. Ensure the 
"Install from a list or specific location (Advanced)" option and then click the "Next >" 
button to continue. 
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3 When prompted for the location of the driver files, enter the location of the installation 
of the software followed by the path to the USB driver files. The default location for 
these driver files is "C:\Program Files\LogTag Recorders\LogTag Analyzer\Drivers\USB 
Interface 2.0". You may use the "Browse..." button in the window that appears, similar 
to the following picture to help you locate the appropriate folder. 
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4 Once the driver files have been installed successfully you will see a window similar to 
the following picture. You may now connect and start using your USB Interface 
Cradle(s). 

 

Note, if you see a window similar to the following picture appear during the installation of 
the USB driver files, you must click the "Continue Anyway" button for the USB driver files 
to successfully install. 
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Manual USB driver installation on Windows 2000 
To manually reinstall the USB driver files, for Windows 2000 computers, open the "Device 
Manager". The "Device Manager" can be started by opening the "System" icon, located in 
the Windows "Control Panel", selecting the "Hardware" tab in the "System Properties" 
window and then click the "Device Manager" button. 
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1 Using the mouse (pointing device), click the right button to display the popup context 
menu, which will be similar to the following picture. 

 

2 Select the "Properties..." option, using the left button on the mouse. 

3 From the "USB Interface Properties" window that will appear, similar to the following 
picture, click the "Reinstall Driver..." button. 

 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



 Chapter 10    Appendix 127 
 
 

4 The will device driver wizard will appear similar to the following picture, click the "Next 
>" button to continue. 

 
5 Ensure the "Search for a suitable driver for my device (recommended)" option is 

selected and click the "Next >" button to continue. 
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6 Ensure the "Specify a location" option is selected and click the "Next >" button to 
continue. It is best that the "Specify a location" option is the only one selected for the 
installation of the USB Interface Cradle driver files. 

 
7 When prompted for the location of the driver files, enter the location of the installation 

of the software followed by the path to the USB driver files. The default location for 
these driver files is "C:\Program Files\LogTag Recorders\LogTag Analyzer\Drivers\USB 
Interface 2.0". You may use the "Browse..." button in the window that appears, similar 
to the following picture to help you locate the appropriate folder. 
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8 If you have chosen the correct folder that contains the driver files for the USB 
Interface Cradle, you will see a window similar to the following picture. Click the "Next 
>" button to install the driver files. 
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9 Once the driver files have been installed successfully you will see a window similar to 
the following picture. You may now connect and start using your USB Interface 
Cradle(s). 

 

Note, if you see a window similar to the following picture appear during the installation of 
the USB driver files, you must click the "Continue Anyway" button for the USB driver files 
to successfully install. 
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Manual USB driver installation on Windows 98 or 
Me 
To manually reinstall the USB driver files, for Windows 98 and Me computers, open the 
"System" icon in the Windows "Control Panel" and select the "Device Manager" tab. 

1 Select the "USB Interface" item that is listed in the "Other devices" group, similar to 
the following picture. 
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2 Click the "Properties" button to display the driver  

 

3 Click the "Reinstall Driver" button to begin the device driver wizard. Click the "Next >" 
button to continue. 
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4 Ensure the "Search for a better driver than the one your device is using now. 
(Recommended)" option is selected and click the "Next >" button to continue. 

 
5 When prompted for the location of the driver files, enter the location of the installation 

of the software followed by the path to the USB driver files. The default location for 
these driver files is "C:\Program Files\LogTag Recorders\LogTag Analyzer\Drivers\USB 
Interface 2.0". You may use the "Browse..." button in the window that appears, similar 
to the following picture to help you locate the appropriate folder. 
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6 If you have chosen the correct folder that contains the driver files for the USB 
Interface Cradle, you will see a window similar to the following picture. Click the "Next 
>" button to install the driver files. 

 
7 Once the driver files have been installed successfully you will see a window similar to 

the following picture. You may now connect and start using your USB Interface 
Cradle(s). 
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Note, if you see a window similar to the following picture appear during the installation of 
the USB driver files, you must click the "Continue Anyway" button for the USB driver files 
to successfully install. 
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Sensor Responsiveness 
Temperature sensors typically respond to changes in the environment temperature in a 
logarithmic way and as such you will find that the responsiveness of temperature sensors 
(how quickly a sensor responds to an environmental temperature change) is expressed in 
terms of T90. T90 represents the time it takes for a logger to respond to 90% of the 
actual change of the environmental temperature.  

For example, if the actual environment temperature suddenly changed from 15° to 45° 
and the T90 of the sensor was 30 minutes, then 30 minutes after this sudden change the 
sensor would be reading (15 + (45 - 15) * 0.90) 42°. In reality, it is rare for the 
temperature of an environment to suddenly change to a very different temperature and 
then suddenly change again, usually it is a gradual incremental process.  

For example, if the actual environment temperature changed from 15° to 45° over a 
period of 5 hours in a linear fashion, that is after 2 hours the temperature was 27° and 
after 4 hours the temperature was 39°, and the T90 of the sensor was 30 minutes, then 
when after 5 hours of this temperature change, that is the actual environment 
temperature was 45°, the sensor would be reading 44.7°. 

The LogTag is designed to produce a rapid response to temperature changes, which is 
possible because the actual sensor element of the logger system is external to the logger 
body itself. You can actually touch the tip of the bare thermistor element with your finger. 
The T90 of the LogTag is less than 5 minutes in moving air, which is very responsive as 
some temperature recorders can take up to an hour for the T90 of the temperature 
change to be recorded. 
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